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Welcome to the first issue of HDRI 3D magazine!

t's been said that change is hard

because people tend to overestimate

the value of what they have and
underestimate what they might gain.
| believe this, and over the past few
months as we've geared up for the first
issue of HDRI 3D, I've had to convince
people that change is good.

This magazine is something I've wanted
to see for some time. When DMG Publish-
ing approached me with the idea, | was
all for it. My motives were not fueled by
business sense, but rather by the benefits
we can all gain from such a magazine.
There's nothing wrong with a magazine
dedicated to just one software applica-
tion, but if you can learn what others are
doing, and how other applications handle
various projects, you're better off for it.
But you're probably thinking, “Dan, I only
use Maya!” or “l only use LightWave,”
which is great. But one of the ways I first
learned LightWave, for instance, was by
reading 3D Studio tutorials. At the time,
there were no LightWave publications,

nor were there any books. By learning
enough about my application, | could
apply the other program's tutorials. The
transition to other 3D tools, such as XSI,
was just as easy. Today, every major (and
even not so major) 3D application has
very similar tools, and it's easier than ever
to cross-reference tutorials.

Beyond that, we want to assure you
that HDRI 3D will be unlike any other
magazine, covering applications such
as LightWave, Maya, XSI, Photoshop,
and much more, depending on your
responses to our reader surveys. And
then we'll take it one step further by
introducing you to the emerging trends
and cool third-party tools on the market,
not as reviews, but as tutorials.

Digital content creation ranges far
beyond 3D modeling and animation, and
this magazine will be right there covering
it for you. HDRI 3D welcomes your com-
ments and suggestions, and we thank
you for your support.

Lhpr (Pola~—




TSUNAMI VT[4] Workstations

Our Tsunami VT[4] workstations offer industry-leading performance and proven reliability, ideal for real-time video editing, live switching,
and 3D animation. Available in rack-mount or desktop configurations, we use only the highest-quality components, including genuine Intel®
processors with Hyper-Threading Technology and your choice of serial ATA or SCSI Ultra320 RAID. Visit www.sharbor.com/build-yours/ and
use our super-easy configuration system to get an instant custom quote, or call us to talk with a NewTek-trained VT expert who will help
you determine your unique solution.
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and amazing particle effects
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the next dimension. An integrated
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rendering needs
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Class on Demand: Complete
Compression for ProCoder 2
Whether you need to deliver content
for the Web, Flash, DVD, DivX, or HD,
these tutorials will assist you in
achieving the best results for your next
project. Under the expert guidance of
Ben Waggoner, you'll learn the ins and
outs of Canopus' ProCoder 2 and so
MUCH MIONE ... v oo die s s 119.99
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Take your work to the next level of realism! This robust and cost-effective
solution for artists has extensive polygon modeling tools, industry leading
Subdivision Surfaces and the revolutionary SOFTIMAGEIXSI toolset. A
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MeshPaint

MeshPaint

Create beautiful surfaces with ease!
Fur, hair, grass - it's all simple with
MeshPaint for LightWave. Features
include surface-aligned modeling
operations, interactive mesh cloning,
automatic population, curve-based
extrusions, and curve-based defor-
mations. Utilize textures, envelopes,
and custom-built gradients . .199.00

Vehicle Modeling Volume 1

This comprehensive video will teach you
how to spline model a Chevrolet SSR.
Gerald Abraham takes you through this
process in several easy to follow 15 - 40
minute sections, so you can leam at
your own pace. Volume | covers the ex-
terior of the car in detail with more than
8 hours of video training
Volume 2

.Sharborcom

800-544-6599

Information 262-548-8120 » Tech Support 262-548-8157 » Fax 262-548-8130 » Hours Mon-Fri 8:30am-5:00pm CST. ©2004 Safe Harbor Computers. A rights reserved
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undamaged. Opened soltware not returnable. Shipping charges not refundable. Returns subject to a 15% restocking fee. Prices subject to change. Not responsibie for typos.

LightWave™ 3D [8]

This major upgrade to the powerful,
Emmy award-winning animation
program includes enhancements in
character animation, faster IK
and FK, new modeling and texturing
tools, bone animation tools,
and more 1289.99

Intuos3 Graphic Tablets

Programmable ExpressKeys™ and
a Touch Strip are right at your finger-
tips for convenient keyboard short-
cuts, scrolling, zooming, brush size
control, and more. Cordless and
batteryless mouse and pen included.
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BY BRAO CARVEY

LW ESSENTIALS

SASLITE

aslLite is a hair and fur plug-in for LightWave that is easy and fun to use.

Saslite is included free with LightWave and is the Lite version of a commercial
product, from Worley Labs (www.worley.com), called Sasquatch. The SasLite
plug-in can be added to all surfaces or to individual surfaces. Multiple layers of SasLite

textures can be added to surfaces. By layering Saslite textures, interesting effects can
be achieved. There are lots of ways to use SasLite, besides hair. In this introduction to
SasLite, we will texture the billiard 8-ball, which is included with LightWave.

SET UP SCENE e SO IR e
FIGURE 1- SET THE LIGHT INTENSITY

1. Load 8-Ball from the LightWave directory (Objects\Games\Billard_Balls\Ball_8.lwo),
and rotate it so the “8" faces the camera.

2. Open the Backdrop Dialog Box (Ctrl-F5) and change the Backdrop
Color to White.

3. Select Lights (L), Properties (P), and then change the Light Type
from Distant to Spotlight and the Light Intensity to 125%. You must
manually enter the number 125, because the arrows default to O
- 100%. SEE FIGURE 1.

ADD SASLITE PLUG-IN

4. Open the Image Processing Window (Ctrl-F8), Click on Add Pixel
Filter, and select “SasLite” from the popup menu.

5. Double Click on the text “SasLite: Low Antialiasing” to open Saslite,
and select Self Shadows, then “OK.” SEE FIGURE 2.

IR

6. Render the 8-Ball (F9). SEE FIGURE 3. e ——— e e

FIGURE 2- IN SASLITE, SELECT “SELF SHADOWS"

7. Note: To keep the tutorial simple, there is only one light at 125% with
default scene settings. You can improve the appearance of your
rendered images with more lights and by placing the 8-Ball in an in-
teresting environment. Remember to enable the Image Viewer (Items
/ Rendering / Render Options / Render Display / Image Viewer), to
view your rendered images.

ADDING SASLITE TO AN OBJECT

8. Select Objects (O), Properties (P), and then under the Deform tab, click Add Dis-
placement to open the popup menu, and select SasLite. SEE FIGURE 4.

9. Double Click on the text “SasLite” and change values to match FIGURE 5. The Fiber
Color should be changed to White (255, 255, 255), then “OK."

10.Render the 8-Ball (F9). SEE FIGURE 6.
FIGURE 3- THE RENDERED 8-BALL

:l? HDRI 3D I1SSUET
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i sing guice chains [ 2 - 11. Add another Saslite Displacement
: (Step 11), and change values to match
FIGURE 7. The Fiber Color should be

changed to Black (0, 0 .0), then “OK."
12.Render the 8-Ball (FO). SEE FIGURE 8.

ADDING GRASS TO THE

BLACK SURFACE

13.Try adjusting SasLite parameters
so the values are greater than the
maximum allowed by the adjustment

arrows. For example, to create grass
with SaslLite, you will need to type in
the Coarseness value (200% or more).

14. Add another SasLite Displacement (Step
11), and change values to match FIGURE
9. The Fiber Color should be a yellowish
color (237, 251, 140), then “OK.”

15.Render the 8-Ball (F9). SEE FIGURE I0.

Try using one SasLite Texture for short
grass with Fur Density at 100%. This will
be the short grass. Add another texture
with low Fur Density 7%, Clumping at
100% and a small Clump Size. By layering
textures, you can get some very interest-
ing landscapes. If you assign different
surfaces to landscape objects, you will
be able to vary SasLite grass textures and
add Clumps of Long Grass. @

FIGURE 9- MATCH STEP 14 SETTINGS TO THESE

BRAD CARVEY
HAS BEEN DOING
COMPUTER
ANIMATIONSFOR
A LONG TIME. IN
1969, BRAD USED
kAN ANALOG
COMPUTER,
WHICH WAS THE SIZE OF A CAR, TO PRODUCE
HIS FIRST COMPUTER ANIMATION. BRAD IS AN
ELECTRICAL ENGINEER AND AN EMMY AWARD-
WINNING MEMBER OF THE VIDEO TOASTER
DEVELOPMENT TEAM. HE PREFERS TO DO
FEATURE FILM WORK. HIS CREDITS INCLUDE
FILMS LIKE MEN IN BLACK, STUART LITTLE,
BLACK HAWK DOWN, KATE & LEOPOLD AND
MASTER OF DISGUISE.

FIGURE 10- THE FINAL GRASSY 8-BALL
e A e e S|
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here is a new. movement
~ happening in art, and it is
_ called digital. For the first
time in history, artists have the
abi]ity to blend a variety of artistic
traditions to create a different form
of creative expression. The title of
~ the cover image is Emergence. A
combination of photography, 3D
sculpturing, painting, and scan-
ning of three-dimensional objects
are used. »




The following images are used in the
creation of Emergence:

Figure O1-Portrait on the beach
Figure 02—-Green and yellow leaf
Figure 03—Red leaf

Figure 04—Green leaf

Figure 05-Brown leaf

Figure 06—Dried kelp

Figure 07-Tree bark detail

Figure 08-3D generated smoke |

Figure 09-3D generated smoke 2

The photograph of the model and the
photo of the tree bark were shot with the
Canon DGO digital camera. This gave me a
6.1 megapixel image. All of the leaves were
scanned into my computer at a resolu-
tion of 1200 pixels per inch with the HP
Scanjet 6300 C, producing file sizes of 30

megabytes and up. The smoke streams are
3D-rendered HyperVoxel objects created in
LightWave [8].

I chose these objects primarily for their
texture, and with each one being so unique
from the other, it was a challenge decid-
ing how to utilize them to complete the

§ 7

final result. | could have gone in a variety

of directions, but | chose to envision the
textures on more of an abstract level and
mold them to become an integral part of
the model. Let’s discover how it was done.

NOVEMBER / DECEMBER 2004
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FIG.10- 10 LAYER SETS

STEP1

To keep the many layers organized, a
series of layer sets was produced. Within
these sets, the appropriate layers will be
placed into them. Each one will be intro-
duced along the way, but | started with the
Background layer set. (Fig. 10)

STEP 2

The tree bark has an interesting biomor-
phic feel to it, so it was ideal to serve as a
background for my human model. After
duplicating the layer (Ctrl-f) and inversing it
horizontally (Edit>Transform>Flip Horizontal),
| used a mask to hide the seams where the
two images came together. Painting with
black on the mask makes the bark go away.
Painting with white brings it back. As a result,
the two produced an interesting symmetrical
array of fluid shapes. (fig. 11)

STEP 3

Next, the background is given a sense of
depth by allowing the viewer to focus more
on the foreground areas. Two techniques
are used to achieve this. First, a new layer
is created. By holding the Alt key on the
keyboard and selecting the Merge Visible
command from the Layers submenu, all
layers will merge into the new one without
merging the original ones. The next step
involves applying Gaussian Blur to the new
layer, because this will serve to provide the
shallow depth of field. (fig. 12)

Once completed, a mask is associated
and edited so that much of the blur effect
is restricted mostly to the center portion of
the background, as shown in figure 13,

HDRI 3D I1ssUE1

FIG. 13- MASK ADDED TO BACKGROUND

FIG. 14- HUE & SATURATION MASK EDITED

STEP 4

The background has a reddish color cast,
so using a Hue and Saturation adjustment
layer, the Saturation slider is taken all the
way to the left, leaving the image B&W.
Because | did not want the color completely
taken away, the mask is edited to isolate
the reddish hue to the foreground areas.

STEP:S

The background still had quite of bit of
tonal information that could compete with
the main subject matter, so a Curves adjust-
ment layer is used to restrict the tonal range
to deeper shades of gray. The white points
on the curve are dragged down to lower the
highlights to a richer tone, as shown in figure




FIG. 16- CURVES ADJUSTMENT LAYER DUPLICATED

FIG. 17- MODEL PLACED IN “GIRL" LAYER SET

totuar

FIG. 19- SCULPTED RED LEAF

FIG. 18- SHEAR APPLIED TO RED LEAF

15. The mask is edited to apply its effect in
the center region of the background.

STEP 6

The Curves layer is duplicated to insure
that the tones are very rich, and once again
the mask is edited to restrict the tones to
the center of the image. (Fig. 16)

FIG. 20— TEXTURING OF THE BODY

STEP 7

Now we are ready to bring in the model. She
was placed into the “Girl 1” layer set organized
on top of the background, and the Distort tool
(Edit>Transform>Distort) is used to stretch her
body up toward the upper right. (Fig. 17)

STEP 8
To change the lower part of her body
into a leaf-like figure, the Shear tool

(Filters>Distort>Shear) is used on the
Red leaf. (Fig. 18)

STEPR:9

The tail is positioned with a mask
added. The mask is edited to mold the

leaf to the model’s lower body. It is also
duplicated several times, and each layer
is edited to sculpt the leaf in the form
shown in figure 19.

STEP 10

Next, the Green & yellow leaf and the
Green leaf is applied to the body. Figure
20 shows how the Green & yellow leaf’s
blend mode is set to Linear Light blend
mode in one layer example. In the lower
layer example, the Green leaf's blend
mode is set to Hue. Both examples
blend well with the skin and maintain the
model's contour. In the next step, let's
discover some details as to how this is
initially applied. (Fig. 20)

NOVEMBER / DECEMBER 2004 .F:




STEP 11

Figure 21 shows the leaf before a mask
is applied, as well as the results after the
mask is edited. The use of the WACOM
tablet for editing the mask and applying
painting techniques is, in my humble
opinion, invaluable.

STEP 12

Here are the results of the Green leaf
when applied. Notice how the mask is
edited to allow the green hue to dominate
only in selected regions. (Fig. 22)

STEP 13

In the same way the tail was created in
Step 8, the Red leaf is added to the head
of the model to represent hair. These lay-
ers are placed into the Head Set folder.
(Fig. 23)

STEP 14

Using the Brown leaf, its textures are
restricted to the model's upper body to
form a type of clothing unique from the
original. No blend modes were used here.
I wanted the original detail of the leaf.
Finally, the kelp is used to form the collar.

STEP 15

The Brown leaf was so successful for the
upper body that | decided to use it as an
additional composite for her face and neck
region, but this time the blend mode was
changed to Overlay. This is an example
without the mask applied. (Fig. 25)
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FIG. 23-HEAD DETAIL WITH RED LEAF

FIG. 24- BROWN LEAF AND DRIED KELP DETAIL
UPPER BODY




Here is an example of the Brown leaf
with the mask edited to restrict its detail to
the face and neck region. (Fig 26)

STEPTL6

Now it's time to bring in the smoke
streams that were rendered in LightWave
[8]. Two images were rendered and saved

out as a TIFF so that the smoke would be
rendered onto a transparent background.
Once the layer was placed, it was resized
and duplicated to compose the steamy
smoke streams around the model. These
images were placed into the Steam 2
layer set that is positioned just above the
“background” layer set but below the
“Girl1” folder. Later on, you will see the
details for creating the smoke streams with
Hypervoxels in LightWave [8]. (Fig 27)

STEPR 17

In this step, more of the smoke streams
were applied, but this time they were
placed into the Steam layer set, which is
positioned above the “Girl 1" folder. These
layers’ blend modes were set to Screen to

enhance the whites. Now the effect is more
J steam than smoky. (Fig 28)
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FIG. 28— SMOKE STREAMS WITH MASK APPLIED IN “STEAM" LAYER SET




FIG. 29- WHITE PAINT APPLIED OVER MODEL'S FACE

o

30- OVERLAY BLEND MODE SET TO WHITE PAINT

L 2 1)
‘L

STEP 18

The Light Streak layer set is placed on top
of all other layers. Within it, a layer with a
small swatch of White paint is applied and
positioned over the model's face. (Fig. 29)

STEP 19

Once its blend mode is changed to
Overlay, a mask is applied to restrict its
effects to the edge of the figure's face and
leaf hair. This will represent the highlights
reflected from above the model. (Fig. 30)

STEP 20

The last step is to give the image a little
more contrast using the Curve adjustment
layer. This did the job.

That's it for the basic image. Now let's
look at some of the settings used to create
the smoke effects in LightWave [8]. (Fig. 31)

SMOKE SETTINGS IN LIGHTWAVE [8]

| used the basic smoke texturing prop-
erties that NewTek provided on their site
with a slight twist of my own settings. |

:ﬂ'-i HDRI 3D I1SSUET

used a lot of experimentation to get the
right amount of particles to interact with
the Wind Effector to show movement
near the top of the smoke stream, with
the lower half left alone. The following
steps will show how the particles were
composed and textured.

STEP]

This is the camera view of the place-
ment of three nulls (ltems>Add>Null)

with particle emitters attached to them.
To attach the emitter, select a null object
and hit the "P” key to get the Properties
panel. Under the Add Dynamics panel,
select Emitter. Now the object has its own
emitter associated with it.

As a note, one null object was created
and associated with an emitter. Hyper-
voxels were used to texture the particles.
When satisfied, the null was cloned (Ctri-C)
twice, and all three were composed in the
camera view. (fig. 32)
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FIG. 32- CAMERAVIEW IN LIGHTWAVE [ FIG. 37- WIND EFFECTOR PROPERTIES

¥ Object Properties

STEP 2

The next four examples are the settings
e used to create the action and behavior of
| | T o e Rateeics]

Figure 33—Generator Paricle Properties

Figure 34— Particle Properties

Figure 35-Motion Paricle Properties

Figure 36-Additonal Paricle Properties

CIEIEE 2

STEP 3
Once the particles are created, a fourth

null is created, but this time, instead of an
emitter being added to it, a Wind Effector

- : — . — - is added. The following shows the options
| FIG. 33 (TOP LEFT), FIG 34 (TOP RIGHT), FIG 35 (BOTTOM LEFT), FIG 36 (BOTTOM RIGHT) l chosen for the Wind Effector. (Fig. 37)
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STEP 4

To texture the particles to look like smoke
Hypervoxels, first open the Effects panel
(Windows>Volumetrics and Fog Options).
Next, add Hypervoxels (Add Volumetrics>
HyperVoxels). The initial settings are shown
in figure 38.

STEP 5

Under the Geometry tab, the Particle Size
is set. After clicking the “T" button next to
the Particle Size, a gradient is set. The options
used are as shown in figures 39 - 41.

STEP 6

Next, the Shading tab's selected; this is
where we get to texture the particles. (Fig. 42)

STEP 7

Five bars are used to define the gradient,
and the Input Parameter is set to Particle
Age. The results of each bar is as shown in
figures 43-47.

STEP 8

Four bars are used to define the gradient,
and the Input Parameter is set to Particle
Age. The results of the Opacity gradient
options are shown in figures 48-51.

YPERVOXEL PROPERTIES

FIG. 39- TEXTURE SIZE OPTION

# Texture Editor - HyperVoweks - Particle Size
T

| e Tema
[ FIG. 41— TEXTURE SIZE OPTION J
[Froroiio —Lix
Paste
Load Save Spate Ea
m. Deactrvale GHERT
SLCER-IT: Shadng . HypeTedse
- e
- OBD
hd 3
=1
A EE 4
+ | Use Al Lights
TEre
=T
I T
~ | Automabc Preview
| Use ZBuffer n Preview
Sgpebe Testuse eschiion v

FIG. 42— SHADING OPTIONS




| # Texture Editor - Hyper¥osels - Color

# Testure Editor - HyperVoxels - Color

————d |

FIG. 44- COLOR OPTIONS FIG. 45- COLOR OPTIONS

FIG. 43- COLOR OPTIONS

¥ Texture Editor -

# Texture Editor - Hyper

FIG. 48- OPACITY OPTIONS

+ff Texture Editor - Hyper¥oxels - Opacity

¥ Texture Editor - HyperVosels - Opacity

g
|
;

1 :
FIG. 51— OPACITY OPTIONS

FIG. 49-OPACITY

OPTIONS
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7 Texture Editor - Mypervosels - Density

STEP 9

Four bars are used to define the gradient;
the Input Parameter is set to Particle Age.
The results of the Density gradient options
are shown in figures 52-55.

STEP 10

FIG. 53- DENSITY OPTIONS

Finally, the Hyper Texture tab is selected
to give the fog some physical character.
The options are shown in figure 56.

There it is. Once rendered, the final
image is saved as a TIFF and brought 7 Tenture b
into Photoshop for editing. |1 hope you
enjoyed this article. If you would like to see

more of my work, please visit my site at
www.chromeallusion.com. &

T =T 8 7% STEPHEN BURNS HAS
‘ .*f DISCOVERED THE SAME
3 PASSION FOR  THE
DIGITAL MEDIUM AS HE
HAS FOR PHOTOGRAPHY
AS AN ART FORM. HIS
BACKGROUND  BEGAN
AS A PHOTOGRAPHER 22
YEARS AGO AND IN TIME,
PROGRESSED TOWARD
THE DIGITAL MEDIUM. STEPHEN HAS BEEN A
CORPORATE INSTRUCTOR AND LECTURER IN o HyperVorels 5.0
THE APPLICATION OF DIGITAL ART AND DESIGN
FOR THE PAST 8 1/2 YEARS. HE HAS BEEN
EXHIBITING DIGITAL FINE ART INTERNATIONALLY
AT GALLERIES SUCH AS DURBAN ART MUSEUM
IN SOUTH AFRICA, CITIZENS GALLERY IN YOKA-
HAMA, JAPAN, AND CECUT MUSEUM OF MEXICO
TO NAME A FEW. PART OF HIS EXHIBITING WON
HIM 1ST PLACE IN THE PRESTIGIOUS SEYBOLD
INTERNATIONAL DIGITAL ARTS CONTEST.
OWNER OF BURNS DESIGN, HE TEACHES DIGI-
TAL MANIPULATION WORKSHOPS IN THE SAN
DIEGO AREA AND NATIONWIDE. HIS TEACHING
STYLE COMES FROM HIS ABILITY TO SHARE
AN UNDERSTANDING OF PHOTOSHOP SO THAT
THE STUDENT HAS THE ABILITY TO INTUITIVELY
APPLY IT TO HIS/HERS CREATIONS.

bl

L FIG. 56— DENSITY OPTIONS
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BY NICHOLAS BOLUBGHEN

ANWWPWWM.BDWL%

he world of electronic commu-

nication has become populated

with faceless personalities hiding
behind invented names. No doubt you've
seen this many times; people who feel
they can get away with anything be-
cause they're using a handle instead of
a real name. It's easier, | guess, to speak
your mind without fear of repercussion
when nobody knows who you are.
Minds are less inhibited, and so are our
expressions. There is a good side to this;
good in that freedom to speak openly
and honestly without fear of repercus-
sion is beneficial to us all. But there's a
nasty side to this freedom as well. Some
people use aliases and email addresses
as hiding places from where they can
assault anybody. Common courtesies are
trampled and forgotten. Libel runs pretty
rampant. Email addresses come and
go. It's a cheap, immature sport. Most
of us who have been using email since
300 baud modems were invented, who
remember when the Internet consisted
of only Bulletin Boards and Gopher, just
accept this as a fact of life and move on.
It's a kind of wisdom, | suppose. But we
become guarded over time, maintaining
a certain distance with our Internet and
email companions. Unless you are cor-
responding with old friends, you never
really know, after all, who is at the other
end. You don’t share everything with
your Internet acquaintances. At work,
you maintain a professional demeanor
and distance.

When | made plans to attend SIGGRAPH
in Los Angeles this year, it occurred to
me that | would be meeting some of
those long-time Internet acquaintances.
CG and compositing artists, studio own-
ers, software engineers and developers,
sales people, customer service reps,
publishers, authors, and many others;
these were people | had talked to on the
phone, corresponded with through email
or instant messaging or on CG forums for
years, yet | had never met most of them. |
was really looking forward to that.

I also knew | would be meeting many
new people — some whose names are
well known, who are the gurus and

forefathers and groundbreakers of our
profession; others who, like me, are the
trench warriors of visual effects, largely
unknown except within the small circle
of artists, coordinators and
software engineers that
encompass our daily lives.
And so, when | arrived in
L.A. on Monday night, |
dropped off my luggage
and headed straight for
a party to start meeting
people.

The funny thing ... |
mean the really funny
thing ... is that | wasn't re-
ally prepared for what hap-
pened next. | had imagined

o |

that | would meet these
people, finally attaching a
face to the name. I'd shake their hands
and say "great to finally meet you” and
maybe we'd talk about our work or
something. What | wasn’t really expect-
ing was that I'd sit down and start chat-
ting and finding out that these people,
formerly only email ghosts, had lives and
(believe it or not) interests
outside of 3D, and families
and life experiences and
funny stories about being
a teenager and everything
... just like normal people.
It is painfully obvious in
hindsight, but it is funny,
too, because it hadn't really
occurred to me Dbefore, |
was so disconnected and
buried in my own tiny real-
ity behind a big monitor
in the bottom floor of a
company somewhere far
away from here.

NICK AND LARRY SCHULTZ SAYING CHEESE

That was the beginning of a transfor-
mation for me. | began to realize that |
had kept these professional acquaintanc-
es at a respectful, professional distance
for so long, it had simply become habit.
I had missed out on the fact that they
are all smart, interesting, living people
— people who believe passionately in
what they're doing — people who take
the bug reports and feature requests and
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really try to make sense out of them to
the best advantage of all the users. Other
artists like me who pound the keyboard
daily, begging the software to perform,
creating miracles out of pixels and elec-
trons and committing not just hours and
days, but blood, sweat and tears to every
pixel of every frame.

So the next day, when | first went to
the exhibition floor, | committed myself
to seeking out everyone | could and
taking the time, if possible, to sit down
and get to know them a bit. | didn’t get
to everyone on my list, but | managed to
spend time with some really great folks
and made friends out of some of those
email addresses and contact numbers.

Over lunch, | met and talked to some
great artists from CG houses all over the
place. 1 just grabbed my sandwich, took
an empty chair at a table, and before |
knew it found myself involved in debates
over techniques, software and hardware
with other artists who, like me, seldom
received the opportunity to share ideas
with people from other companies.
“What software do you use for X task?"
“Why do you use it?” “You should really

try Y software because....” "Z software
SUCKS!" Yeah, there were many “Z
software SUCKS!"-- “No, it doesn't”
discussions.

| got to have a long talk with Steve Hill
from 2D3, whom | had plagued with fea-
ture requests and bug reports for years.
Steve, like so many others out there, is not
just a technical support specialist. He's a
really smart man who's strongly dedicated
to his product and his user base. | spent
an evening listening to the childhood
mayhem stories of Larry Schultz, who
has been a LightWave artist and author
for ... well ... way longer than | have.
| hung out with Timothy Albee, author
and maker of Kaze: Ghost Warrior, and
| happened across the inimitable Steve
Worley, creator of such software marvels
as Sasquatch and FPrime. | ran into them
at a party. Tim Albee and | sat on either
side of Steve, like bookends on the way
back to the hotel and, a little drunk, grilled
him about his software. | mean, how many
times are you going to have one of your
favorite software engineers as captive an
audience as that? | hung out a lot with
the Wordware folks, Wes Beckwith and

:Ef? HDRI 3D I1SSUE!

Steve Warner and the gang. | also got to
meet and talk to a bunch of the NewTek
crew ... you know, the people LightWave
artists complain to when software doesn’t
behave as expected? It was great fun
cornering Dr. Andrew Cross, THE ear of
LightWave software development, and
suggesting a load of “really important”
feature requests. | hung out
with  William “Proton”
Vaughan and Deuce Bennett
and Ben Vost and others
during those days, getting
to know WHO they are, not
just what they are. What a
bunch of great guys.

| actually got to meet and
talk with Dick van Dyke,
who has been a LightWave
artist since the Amiga days.
He was just sitting there in

1
YS

the audience at the NewTek
stage, so | wandered over
and introduced myself, eventually sit-
ting down with him once he struck up
a conversation about LightWave [8]. It
was a little surreal at first, listening to him
offer his thoughts on the new software,
and responding with my own remarks
and opinions. | mean, who ever knew
Dick van Dyke was just another CG art-
ist like the rest of us?

Well, OK, not exactly
like the rest of us. We
can't all afford a 427
plasma monitor. But
what a pleasant fellow
he turned out to be.
That one experience,
more than any other,
really served to crystal-
lize a feeling that had
been growing all week
— that all of us are just
people working hard to

A

do our best, that we all
feel the joy of our suc-
cesses as poignantly as the pain of our
failures, even if we're giant movie stars,
or Oscar winners, or coding geniuses, or
brilliant artists, or famous personalities,
or just the quiet artists in the corner,
pounding out our CG workload each day.

Work will be a little different for me
now. Not that the job has changed. | still
have to create impossible imagery using
hardware and software pushed right to

BONDING WITH THE WORDWARE GANG

3




the edge, and often over it. My software
or hardware will still fail me from time to
time. That's the price we pay for working
at the bleeding edge. But it's easier to
take, now that | know the people at the
other end are working just as hard as | am,
just as long every day, and that they're just
as driven, detail-oriented and obsessed
with perfection.

What a difference a face makes.

t is now the evening before | have to

submit this piece to editorial. Disaster

has struck, bringing us at Rainmaker
an even more poignant reminder that we
should each do everything we can to know
and enjoy those around us, to benefit from
their experience and personality.

Rainmaker lost its Skipper, President
and CEO Bob Scarabelli, this morning.
Bob died of natural causes while biking
near his home on Vancouver's North
Shore.

It's easy to think that a loss like this
might not have much impact on the
day-to-day operations of a company
as large as Rainmaker — easy if you
didn’t know Bob. | once sat in a general
meeting during the industry slump early
in 2002 and watched Bob choking up
as he announced that Rainmaker, for
the first time in its history, was forced
to implement job cuts. It ended up only
being a couple of jobs, but to Bob, it was
like sending members of his family out
into the cold.

Bob was the kind of guy who would
appear at my desk from time to time just
to check out what | was working on. It
seems the company was never too large
for him to spend at least a little time
talking with everyone. He was a busy,
driven guy, but never failed to hear you

out if you needed his ear.
Bob was like our Dad.

He set the tone for the
company, as a good leader

NICK WITH ALICE & CHARLES EDGIN, PUBISHERS OF HDRI 3D

should, always making
known that people were his highest
priority. He knew that the highest quality
can only be achieved by the best people
under the best circumstances. When Bob
regarded Rainmaker, he knew it could be
such a place and he strived every day to
make it so.

The industry has lost a visionary, a man
of passion and strength, and our leader.

And now, when [ look around the
room where | work, where | share
my days with a powerhouse of tal-
ent, I'm reminded that any of us can
switch off without notice. We're all
human, after all, and each of us is
worth getting to know.

We all miss Bob; surely not
more than his wife and two young

ATLANTIS, DEAD LIKE ME, AFTERSHOCK:EARTH-
QUAKE IN NEW YORK, VOYAGE OF THE UNICORN,

NICHOLAS BOUGHEN IS A
SENIOR VISUAL EFFECTS
ANIMATOR AND LEAD LIGHT-
ING ARTIST AT RAINMAKER
IN VANCOUVER, BRITISH
COLUMBIA, CANADA. HIS
CREDITS INCLUDE /, ROBOT,
GARFIELD, = GOODBOY!,
STARGATE SG-1, STARGATE:

children do, but he was a huge
presence among us, and we find
ourselves now facing a large empty
place where he was. @

SNOW WHITE, AND OTHERS.

NICHOLAS IS THE AUTHOR OF THE BEST
SELLING LIGHTWAVE BOOK LIGHTWAVE 3D 7.5
LIGHTING, AND ITS NEW 2"° EDITION LIGHTWAVE
8 LIGHTING. HE HAS RECENTLY RECEIVED AN
EMMY NOMINATION FOR OUTSTANDING SPECIAL
VISUAL EFFECTS IN A SERIES FOR HIS WORK ON
THE TELEVISION SERIES, DEAD LIKE ME.
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';‘ GAME MODEL
QUICKLY AND
BFFICIENTIY

his tutorial will take you through the

process of building and texturing a

game model in Maya. It will show
you that with the help of a few handy plug-
ins and a digital cam or good reference,
it can be done in a fairly quick amount of
time. | will go into more detail with the head
since it's what people tend to judge more
closely. Then you should be familiar with the
tools and be able to follow the creation of
the remaining parts with ease. This tutorial
uses references I've collected, but | keep the
descriptions open enough so that you're not
limited and you should be able to follow no

3D ISSLE 1

i

matter what human ref you use.

Go to Highend3d.com or use a search
engine to download: Ultra Image
planes, CPS, and M| Poly tools. Install.

2C.ather as much reference material as
possible. I will be using my mug shot
for the head ref. (See Ref Step 2 Next page)

Make sure the front and side are
3scaled correctly; an easy way to do
this is with rulers in Photoshop. Most
of the time you will run into problems

with camera distortion, so the more
images of the ref you have from
different perspectives the better. Save each
separately.

Next, open up Maya and execute

the Ultra IP plug-in. Create and load
in the images accordingly and press
the Create Front and Side Camera tab.
Make sure to move the planes out of
the way by setting the Z coordinates in
the Ultra Ip menu to Front -20.000, and
the Side Camera to -20.000. | also prefer
to uncheck the grid in the Show menu




above the perspective window. Now we
are all set up to model the head. (See Ref
Step 4)

HEAD: MODELING

Hit spacebar to maximize the front
window.

260 to Polygons > Create Polygon tool

I will start by outlining the eye. Twelve
sides should be enough.

MAYA TUTODRIAL

=
|-

=8 e

MODELING STEP 3- START BY OUTLINING THE EYE

MODELING STEP 4- EXTRUDE EDGES

MODELING STEP 6- POSITION EYE AS SHOWN

4Next, right-click on the geometry and
enter Edge mode. Select all the edges
and go to Edit Polygons > Extrude Edge.
You will see your Manipulator Tool pop
up. Left-click on the small, light blue circle
(this will move the tool to the center of
your geometry). Now you can left-click
the center and scale the extrusion out.
Right-click to enter Vertex mode and
move verts around so it looks similar to
the image.

We need to make an eyeball. Create >
Polygon Primitives > Sphere Options >

enter 11 for subdivisions around axis and
height.

Rotate 90 on the X-axis and position

it accordingly, also moving the outer
eye geometry to accompany it. (I usually
put the eyeball in a separate layer to avoid
selecting it).

Next, we will use M] Poly Tools ELS
7(edge loop split). Select a vertical
edge in the outer eye geometry and M/
Poly Tools > Edge Loop Split. Another
ring around your geometry should have
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appeared; you can control the position
by changing the Slide channel in the right
channel box. Slide it closer to the center.

8Setect the center poly and push it in
towards the eyeball.

Split the outer eye again and start push-

ing and pulling the outer verts according
to the ref image. Make sure you keep the
edges as evenly spaced as possible. This will
benefit you with deformations later on. Go
back and forth between the views, making
sure each vert is placed properly. Keep in
mind that it's very rare to find perfectly
matching front and side images, so you will
have to eyeball a lot along the way. As you
can see on my model, the geometry fits snug
in front but not as close in the side view; as
long as you're close it will be OK. I think it's
more important to use the front as a guide,
since you will be using the same front image
for the texture.

Select the bottom five edges and
1 Oextrucle down. Sculpt. Do the same
with the upper four edges and for the re-
maining three, extrude and snap to center.

1 1 Merge the two verts together on
the right.

1 2Extrucle the upper and lower edge
of the bridge of the nose and

merge the loose verts.

1 3Sculpt on each of the views.

Next, we will do the mouth. Same
1 4as the eye, we will use the Create
Poly tool. (note: CPS has a handy tool
window that makes it easier to select tools)
Male a 10-edge outline of the mouth.

:EP HDRI 3D I1SSUEI
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MODELING STEP 7- EDGE LOOP SPLIT

MODELING STEP 8- PUSH CENTER POLY IN

MODELING STEP 13- SCULPT ON EACH VIEW

MODELING STEP 14— CREATE QUTLINE OF MOUTH




MODELING STEP 15- EXTRUDE & SCULPT MOUTH EDGES

MODELING STEP 20- EXTRUDE CHEEKS

MODELING STEP 23- ETRUDE AND MERGE NOSE
-

MODELING STEP 24- YOURS SHOULD LOOK LIKE THISJ

MAYA TUTORIAL

Select all edges and extrude in.
1 55cu|pt and delete the face closest
to grid since we are going to mirror it later
on. Leave the mouth slightly open so you
can easily tweak if needed.

1 65elect the outer rim of the mouth
and extrude.

1 7Sculpt in all views.

1 85e1ect the eye socket and mouth
piece and Polygons > Combine.

1 gMerge the upper lip verts as shown
in the image.

2 O Extrude the two cheek edges down,
and then extrude again two more
times for each loop.
2 1 Merge the closest verts. Sculpt.
2 25e]ect a vertical edge above the lips
and ELS to add another ring. Do the

same to the upper cheek and nose section.
Sculpt.

2 3Extrude the upper part of the nose
to the bottom and merge.

2 So far you should have something

similar to the image in terms of

structure.
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2, 5Next. extrude the jaw edges.

2, 6Merge the loose verts.
i

2, ?There are two edges on the forehead
» I that are too close together; to con-

serve polygons and even out the structure,
we are going to delete them. Then, merge
the loose verts to opposite ends, creating _
two triangles. (Note: you want to limit — o ~

triangles on your mesh as much as possible, |_ MODELING STEP 25- EXTRUDE THE JAWS ) MODELING STEP 27- LIMIT TRIANGLES ON YOUR MESHJ
since there are no deformations on the fore-
head, besicles, maybe the eyebrows moving
up it should be OK.)

iy

2 8 Now we can extrude the rest of the
head.

2 9 Sculpt.

3 Q Extrude the neck and merge verts.
)

a

MODELING STEP 28- EXTRUDE THE REST OF THE HEAD MODELING STEP 29- SCULPT THE HEAD
\ A

-

3 Select an edge in the empty spot
where the ear should be and Edit
Polygons > Spiit fill hole.

iy
it

3 Split polys like the image using the
Edit Polygons > Split Polygons tool.

3 3Extrude faces in the center of the
ear.

3 Split and extrude different parts ac-
cording to the specific details of your
character’'s ear; remember that it doesn't

have to be a very high poly, basically just the | \iope( NG STEP 30- EXTRUDE NECK & MERGE VERTS | | MODELING STEP 31- FILL THE HOLE WHERE THE EAR IS
outer rim and cavity should work. Sculpt. = <

UT]

L MODELING STEP 32- SPLIT POLYS AS SHOWN HERE ) kMODEL[NG STEP 33- EXTRUDE FACES IN CENTER OF EAR MODELING STEP 34- SCULPT BASIC EAR SHAPE
L.

>
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MAYA TUTORIAL

OK, now that we have a well-struc-
3 5tured base, we can mirror and add
details. Make sure all your verts at the half
are centered on the grid. Open the CPS tab
and check the mirror and stitch option and
choose — X for the mirror direction. This will

automatically smooth your model. Open
the CPS Ctrl tab and hit the minus sign, and
you're back to the unsmoothed version.
You may also want to Edit Polygons >
Normals > Soften/Harden > All Soft.

3 ﬁb:trude in the nose.
&
3 ?Do the same for the lips.

From this point on, it's a matter of
3 8sculpﬁng. pushing, and pulling the
verts as needed, adding a few loops and
looking closely at your gathered reference.
This is my final head model before | move

L MODELING STEP 35-SOFTEN THE POLYGONS L MODELING STEP 36-EXTRUDE IN THE NOSE

on to texturing.

MODELING STEP 37- EXTRUDE IN THE LIPS

FRONT VIEW OF THE FINAL HEAD BEFORE TEXTURING SIDE VIEW OF THE FINAL HEAD BEFORE TEXTURING




HEAD: TEXTURING

First delete the CPS from your mesh,

go to the CPS CTRL tab and press the
icon that's the 3rd down on the right, the
icon with the scissors. When it asks you to
delete base geometry, say yes.

For the Head, | will be using Edit
> Cylindrical Mapping.
Make sure you assign a checkerboard

: Polygons

texture to your model to fix and prevent
any stretching.

Once the checkerboard is evenly layed

out, select your object, and in the UV
Editor, go to Polygons > Uvsnapshot,
enter in 1024 x 1024 and export. Bring
the snapshot into Photoshop and use it as
a template for placing and blending your
reference images together. The front im-
age should easily fit on the UV map, but the
sides will need a bit more tweaks and color
adjustments. Once you have one side done,
copy the layer in Photoshop, duplicate, and
flip to use on the other side. Adjust so each
side is not exactly the same. Here is what |
came up with. (See UV Map at Right)

Once the texture is applied on the

model, you will need to fix certain UVs
and verts for it to look how you want. (See
three images at bottom of this page)

= For the eyeball, | Planar Mapped and
+'used my pupil on a 256 x 256 off-white
background.

TEXTURING STEP 2- ASSIGN A CHECKERBOARD TEXTURE
- A

TEXTURING STEP 3- REFERENCE IMAGES ADDED

FRONT VIEW OF TEXTURE APPLIED TO THE MODEL L
\ "

VIEW OF TEXTURE APPLIED TO THE MODEL

SIDE VIEW OF TEXTURE APPLIED TO THE MODEL
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LTOF{SO 1- START WITH 6-SIDED CUBE & SPLIT 'I'W\CE)
|

TORSO 2- DELETE FOR NECK AND ARM HOLES

\

TORSO 3- SPLIT & SCULPT ACCORDING TO YOUR REF J L
| &

LEGS 1- SPLIT TWICE AT WAIST AND KNEE

|

n

LEGS 2- DELETE WHERE WAIST & OTHER LEG WILL BEJ L
.

LEGS 3- SCULPT AND MIRROR GEOMETRY

y.

ARMS 1-ARMS ARE MUCH LIKE THE LEGS

) HAND 1- SCULPT A CUBE SOMETHING LIKE THIS
|

MAYA TUTODRIAL

BODY: MODELING (speed session)

UPPER TORSO

A Start with a six-sided cube and split
Iy
I twice vertically.

# Extrude the top face in and delete for
#£==the neck. Do the same for the arms.

o Next, split and sculpt according to your
% reference.

LEGS

4 Start with a six-sided cube, stretch ac-
! cording to your ref, and split twice at
waist and knee.

# Delete poly where the waist will attach
#sto the upper torso and also delete
where the other leg will attach.

#yAdd more loops and sculpt. Mirror
1?a,,g-‘geometry.

ARMS

1,45 Arms are basically built the same way

| as you did the legs, making sure there
is enough geometry around the elbows
and shoulders to deform properly.

HAND

#1 Begin with a cube and split and

& sculpt so you have something similar
to the image.
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9 Extrude the faces where the fingers are

eand split down the hand, like the image.

) Next sculpt, split, and make sure you

have enough loops around all the joints

b=

of the fingers.
SHOE

A This will be simple once you've com-

I pleted the previous sections. Start from
a box, sculpt, and split according to your
reference.

Here's the completed body. (See image,
far right)

BODY: TEXTURING

F} I used Cylindrical Mapping for just about
I everything except the hands, for which
I used a Planar Map on the top and bottom.

Malke sure you always hide your seams in
the most unnoticeable areas (under arm,
between legs), and try to match them up as
best you can in Photoshop.

Note our final product, it contains 4300
Polygons. @

EDDIE  ALCAZAR IS
CURRENTLY A PART OF
WWW.ALCAZAR-
ENTERTAINMENT.COM
WHICH HE, GREG LEMON
AND TWO OTHER INDUS-
TRY FRIENDS STARTED IN
EARLY 2004. SINCE THEN THEY HAVE BEEN BUSY
WORKING ON AAA GAME TITLES, COMMERCIALS
AND OTHER 3D WORKS. “OUR MAIN TARGET
IS DELIVERING QUALITY ABOVE THE CLIENT'S
EXPECTATIONS. WE TRY TO HANDLE ANY 3D
RELATED JOB NEEDED. OUR EXPERIENCE HAS
RANGED FROM PLATFORM GAME CONTENT
CREATION AND VFX TO MEDICAL AND ONLINE
GAMES.”

EDDIE HAS DEMONSTRATED AND PROVED HIS
SKILLS WITH OTHER COMPANIES IN THE PAST,
WORKING ON HUGE TITLES SUCH AS EAS
MEDAL OF HONOR'S PACIFIC ASSAULT AND
BREAKTHROUGH AND HAS ALSO BEEN WORKING
ON DIRECTING HIS FIRST INDEPENDENT FEATURE.
HE CURRENTLY RESIDES IN SAN FRANCISCO.
HIS ONLINE PORTFOLIO CAN BE SEEN AT
WWW.EDDIEALCAZAR.COM

HAND 2- EXTRUDE WHERE THE FINGERS ARE

lHAND 3- MAKES SURE JOINTS HAVE ENOUGH LOOPS
-y

SHOE 1- START WITH ABOX AND SCULPT TO FIT RE

F

_J

L THE COMPLETED BODY PRIOR TO TEXTURING

BODY TEXTURE 1-TRY TO HIDE YOUR SEAMS

OUR FINAL CHARACTER

4

4300 POLYGONS MAKE UP THE FINAL PRODUCT

VIDEO GAME CHARACTER QUICK AND EASY




BY PETER HARTWIG

Integrating CG Into Real World Environments 101

arrying CG and live action is
getting to a point where it's

almost
does or needs done. Even small commercial
jobs with low budgets are integrating CG
elements into whatever was originally shot,
which is quite extraordinary when you take
into account that this was considered a
huge task just a few years back.

something everyone

In this article, I'll sum up a few simple
methods of CG integration, and I'll show
you some tricks that really put the CG in the
scene simply and easily.

Often there are issues with the lighting
not being completely right, or maybe just
not nuanced enough. Also, things like
highlights burning out or shadows in the
plate can cause trouble. Fear not! We'll look
at these problems right now.

For this example, | went out to the
parking lot at my office and took two
pictures with a Canon D10 camera, in
16-bit Canon raw format. The first image
(PIC 1) is going to be the plate and the
second (PIC 2) is the HDRI probe. A nice
thing about the CRW format; this camera
shoots in 16-bits, which makes one image
enough for HDRI. I didn’t have a proper
mirror ball, so | used a chrome Christmas
ball for this one.

In Photoshop CS, | imported the im-
ages and saved them out as 16-bit TIFF files,
which are supported directly inside XSI.

In this example, | will be working on a
still image, just to keep things simple, but
the plate could just as well be live action
film that was tracked. | usually track all
my things in SynthEyes, which makes this
process simple to do on clips, as well. If
possible, you should still try to get the
plates in 16 or 12-bits from the scanner.

—

PIC 1- BACKGROUND PLATE IMAGE

= I 1) Togoplal

The tutorial assumes you know your way
around XSI, so I won't go into any detail
about where to find the buttons, etc.

The first things I do in XSI are load the
plate in as a rotoscope image and align
the camera to it. Use the grid for this, and
find some lines to align to. Next, create a
plane, a cylinder (PIC 3) and a spot light.
Also, go ahead and delete the default light
now. Turn on the shadows for the spot
and move it around to make the shadow
from the cylinder fall like the shadow in
the plate does. Move it somewhat far
away, and in a viewport, look through
the spot and make sure the cone doesn't
cover too much more than what you see
in the scene.

Now that we've got that set up, let's set
up the HDRI lighting really quickly, as this
will give us our basic lighting that we will

be mixing with in the fxtree later.

PIC 2- CHROME CHRISTMAS BALL

Very often, | can’t be bothered to unwrap
probe images, so | just go ahead and create
a large sphere that surrounds the scene and
Planar Map the probe image on it. Then for
the shader | use a Lambert and plug the
image into Incandescence, Ambient and
Diffuse. Also, turn off Primary Visibility for
the sphere. (SEE PIC 4)

Go ahead and add a few more simple
objects to see how the Final Gather will
work.

NOVEMBER / DECEMBER 2004 EP:




Then it’'s time to turn on Final Gather
in the render region. You'll probably
have to fiddle a bit with the intensity
parameter for the Incandescence on the
environment sphere. (SEE PIC 5)

That’s all the time we'll spend on that ...
go ahead and fine-tune it yourself.

The next thing we'll look at is grabbing the
gobo of the plate and putting it in your light.
First of all, add a Camera Texture Projection
to the plane, and put a Constant Shader with
the plate as color on it. Then change to the
spot light viewport, and maximize it. Right
now, | can’t seem to find an easy way to
render out a spot light, but you could easily
create a script to align a camera to the spot,
etc. For now, | render a full screen render re-
gion, and right-click on it to save the region.
Remember to turn off Final Gather for this
render, and hide all the geometry except for
the plane. (SEE PIC 6 next page)

Next, open this image in a 2D software
package, like Photoshop, and use a tool to
adjust the levels to show the Shadow/Light
line, and Paint/Blur whatever you need.
(SEE PIC 7 next page)

Now, set up a shader network for the
light, like in PIC 8, and try rendering it with
a few different objects in there to see how it
works. Use the mixer to control the intensity
of the gobo light. Once it works, leave it for
a while; we're going to render out some
passes and put it back together in the fxtree
and tune it there.

We're going to use a few passes for this
next part. First of all, we'll make a pass for the
gobo alone to control the light and shadow.
Then we're going to set up a Final Gather
pass for the main light in the scene, and then
1 like using the Fantastic Dirtmap plug-in to
create an Ambient Occlusion pass.

Let's quickly set them up. For the gobo,
override all materials and give them a white
Lambert. This pass should not have Final
Gather on. The FG pass overrides the intensity
of the spot and sets it to 0. Set up your Final

Gather setting to whatever fits your project. S _— S —
| have used the Camera Projection again, to PIC 5- MAKE ADJUSTMENTS TO THE INTENSITY PARAMETER

:EFI HDRE 3D 1SSUET
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PIC 6- HIDE ALL THE GEOMETRY EXCEPT FOR THE PLANE
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PIC 8- SET UP A SHADER NETWORK FOR THE LIGHT AS SHOWN

project the plate onto the plane, and then |
piped a solid black constant shader into the
shadow port of the material on the plane to
allow for the shadows from the FG. Last but
not least, set up an Ambient Occlusion pass
by overriding all materials with a constant
shader with a Dirtmap shader on it.

Go ahead and render all the passes
before we go into the fxtree part...

Switch to the Compositing layout, and load
in all the passes. Now, use the Final Gather
pass as base, multiply with the two other
passes, and adjust the intensities here. This
gives you much better control to change
shadow colors and values, etc., than if you
did it in the 3D scene.

Another compositing trick when matching
lighting is to load the plate and the CG, then
start turning up the exposure while making
sure that the whites burn out at the same
time in your CG as in the plate; do the same
for lower exposures to make sure the high-
lights stay visible at the same exposures.

This was just a quick and easy way to
add CG elements to live action footage. The
gobo effect really helps sell the idea that the
CG is in there for real, so it's a good trick
to know. Other than that, it's a question of
breaking it down and constantly focusing
on what seems wrong and why.

| really hope some of you picked up
a few tricks that can help you out ... till

next time... &

PETER HARTWIG IS A
FREELANCE TECHNICAL
DIRECTOR WORKING
IN DENMARK AT THE
£ MOMENT. CURRENT
“ PROJECTS INCLUDE FEA-
TURE FILMS BY DANISH
DIRECTORS LARS VON TRIER AND CHRISTOFFER
BOE, AND SEVERAL TV COMMERCIALS. PRIOR TO
THIS PETER WORKED AT FRAMESTORE CFC AS
LIGHTING TD ON HARRY POTTER AND THE PRIS-
ONER OF AZKABAN AND THUNDERBIRDS.
AT 23 YEARS OF AGE PETER STILLHASN'T RECEIVED
ANY FORMAL TRAINING, AND HAS BEEN LEARNING
BY DOING, AND NOT BEING AFRAID OF ASKING.
AT THE MOMENT PETER LIVES WITH HIS GIRL-
FRIEND IN COPENHAGEN DENMARK. MORE
WORK CAN BE SEEN ON WWW.IDIOTBARN.COM

NOVEMBER / DECEMBER 2004 EP:




BY BRUCE G. WOLOSHYN

SUARGAME SG=1
“LOST CITY PART 2”

RAINMAKER'’S DIGITAL
EFFECTS SUPERVISOR
BRUCE G. WOLOSHYN
SAYS IT'S ALL ABOUT
THE PEOPLE.

GM's Stargate SG-1 has been

fortunate enough to be nomi-

nated once again for a Primetime
Emmy for Outstanding Special Visual Effects
for a Television Series. The visual effects crew
at Rainmaker was instrumental in acquiring
that nomination.

THE EVIL ANUBIS HAS BEGUN A SYSTEM-
ATIC ASSAULT ON THE EARTH, AND THE
PLANET'S ONLY HOPE FOR SALVATION
ONCE AGAIN RESTS WITH STARGATE
COMMAND'S ELITE TEAM, SG-1.

When | first heard about this episode
(the season finale of our 7th year), it was
described as the biggest effects episode
ever for Stargate SG-1, not only in the
volume of work, but in the complexity of
the visual effects shots. An alien planet
covered in lava; an aerial battle over the
Antarctic; a firefight beneath the ice; the
“freezing” of Colonel Jack O'Neill. The
episode’s description sounds grand, but
for our team, the visual effects execution
was all the more remarkable. These shots
not only sounded impressive to me, they
sounded just plain cool. And creating
images that are “cool” has always been
something that drives our team to put
in the hours and come up with creative,
near-impossible solutions to the many
challenges of creating a stylistically
strong, believable SG-1 universe.

Of course we are armed with the latest
technology has to offer. From LightWave

HDRI 3D I1SSUE!

EMUIMYY NOMINANTION

THE RED CARPET AT THE SHRINE AUDITORIUM.

and Maya, to Inferno and Fusion; from
SGI to Boxx; we have it all and it all helps.
But from the first sketch to the delivery of
the last pixel, it is the people of this visual
effects team, not the technology, who
created all these “cool” images.

And it is the people for whom the
Emmys People
James Tichenor, our Visual Effects Pro-
ducer, and Michelle Comens, our Visual
Effects Supervisor, who led our team
with enough direction to maintain shot
consistency and to tell a good story, but
also provided enough freedom to let
the artist teams enhance concepts and

are presented. like

contribute their own designs and ideas.
It's for the lead artists who shoulder the
responsibility of working with their teams
to ensure that every shot is completed to
the satisfaction of our supervisors and
executive producers.

There are many, many other people
behind this nomination as well. Without
our IT staff, we'd never make it from
one day to the next. Without our visual
effects support staff, we'd never know
what we were doing from one day to the
next. And as with any ballot, the number
of names is limited. There are too many
artists, technicians and coordinators on
our team whose names didn’t make it
on to the nomination ballot, not because
their contributions were unworthy of
note, but simply because there were
not enough slots for them all. They are
all dedicated team members, without
whose talent and hard work these shows
could never be competed.

I'd be lying if | said that these nomina-
tions aren't special to me. As a farm boy
growing up in the sixties and seventies
watching shows like Star Trek and Space:




EMMY NOMINATION

BRUCE AND SENIOR ANIMATOR, NICK BOUGHEN.

1999, |1 dreamed of working on such
amazing shows. And now, here | am, liv-
ing the dream. | try to remind myself of
that every once and a while when intense
schedules and production problems take

/ | TR TR
j£./ [ ‘ e

THE EMMY BANNERS HANG AT THE SHRINE AUDITORIUM.

their toll on my stress level, my fam- It is made all the more special by the
ily, and my team. | feel privileged to be company we keep. This year's other
where | am. It is a unique and wonderful nominees include the television series’

job to be involved in creating this superb Dead Like Me, Stephen King's Kingdom

work. Receiving recognition from our Hospital, and Star Trek Enterprise. All of

peers for something in which we take | these are shows | admire. All of them are
such pride is, indeed, very special. | peopled with extraordinary talent. &
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BY CRAIG MONINS

ello again. In the last two issues

of Keyframe, we were looking at

various rendering, post, and vfx
issues. It's time now for the third part of
this small series, where we will be looking
at multi-pass rendering (MPR).

MPR is a dead simple concept to get
your head around, and there are a few
different ways of doing it depending
on the situation and its requirements.
Basically what MPR involves is rendering
off different elements of the scene, and
recombining them in a compositor where
the actual “look™ is developed. In many
ways, it's similar to the techniques we
went through back in Keyframe Issue 39.
The difference here is that we are separat-
ing out the elements from the Renderer,
the Specular, the Diffuse, the Reflection,
etc. This way we can use our compositing
program to adjust properties much more
quickly and easily than we could in 3D by
playing with texture and light settings. It
also gives us the option to explore a great
many different looks until we get the one
that's just right.

This technique is common as muck in all
the big animation and effects studios, as it’s

simply the quickest way to work. Certain 3D

packages have MPR options built into them
for this very reason, Maya and CAD, most
notably, and of course Pixar's Photorealistic
Renderman is famed for the way it delivers
different render passes for just this sort of
work. In fact, its ability to handle different
elements in this way is one of the things
that makes PRman useful as a renderer in a
production environment.

LightWave does offer an MPR option
of sorts in its Photoshop export filter.
Unfortunately, this is cumbersome, and
pretty useless, and offers nowhere near as
much control as the techniques I'm going
to show you here. It's also worth noting that
this method of doing multi-pass rendering
works with just about any 3D software, even
Poser. So let's get to it.

e
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STOP THE PRESSES

M y good old MPR tutorial has a piece about
creating an Occlusion layer for the Rendering
passes, and how to make one up in LW. | found this on
the net today. which is a plug-in specifically for creating

Ambient Occlusion passes in LW.

http://www.informatik.hu-berlin.de/~goetsch/AmbQOcc/

T,
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MPR FOR LIGHTWAVE

First of all, go download some files to work
with. You can get all my example files from
the HDRI Web site at: www.hdri3d.com/
resources.

The first thing I'm going to take you
through is how to set things up to give a
set of different rendered passes.

OK, for simplicity’s sake, we'll only worry
about the character in our image. We want
to create a set of alternate scenes containing
different versions of the model, one for each
render pass. First things first. In the Object
Properties render tab, make all of the other
objects with the exception of the killer un-
seen to the camera, and set to Cast, but not
Receive or Self Shadow. (Image_01)If you've
been following the past couple of tutorials,
you should remember how to do this nicely
and speedily with the Spreadsheet Editor (or
the new Scene Editor in 8). Now Save Scene
As, and choose an appropriate name. This
will become the diffuse (or beauty) pass, in
which the character is rendered off normally
as if MPR were not being used.

Once again Save As, and choose a new
name. We'll start by setting up the Occlu-
sion pass, so shot_ ocl.lws. The Occlusion
pass (or Shadow pass) gives us a render
that basically contains data about how
strongly illuminated each point on the
mesh is. Once in a compositor, this can
then be used to selectively shade different
elements of the render in subtly different

ways as we chase down that perfect look.

So now crack open Modeler and open
your mesh. Save As, and call it, perhaps,
mesh_ocl.lwo. What we want to do with this
alternate model is to remove all its surface
properties with the exception of the Bump
map. If you look at the image (Image 02)
you can see that all the surfaces have been
changed to pure white, with 100% Diffuse,
and everything except the Bump gotten rid
of. Switch on over to Layout, and if the model
hasn’t automatically replaced itself, choose
Replace With Object, and select the new
mesh_ocl mesh. Finally, make sure only Ray
Trace Shadows is turned on, as we don't need
any Reflection, Refraction, or so forth here.

If you now render a frame, you'll get the
following image (Image_03), or something
like it depending on your mesh and lighting.

This Occlusion pass does us another favor
also. Without any of the colored texture
detail getting in the way of our perceptions,
it is much easier to get a real idea of just
how good (or bad) a job we have done with
our lighting set up, so right away we can
tell that this render is shaping up well based
on the shading alone, which is the most
important part of good CG renders.

Next then we'll go for the Specular, Back
in Modeler, open the original object, and
basically do exactly as before, except this
time, you'll want to make the surfaces pure
black, with everything except the Specular
and Bump channels turned off. Again, we
make another copy of the scene using
this model, called shot_spc, or something
equally as appropriate. Again, we only want
the Traced Shadow option on. Render this
off. (Image_04)

IMAGE 4- THE SPECULAR PASS RENDERED
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IMAGE 5- SETTINGS FOR THE
REFLECTION SURFACE

Next comes the Reflection pass. Same
thing again, new model and scene, with
the model’s surfaces being the same as
for the spec, but obviously with Reflec-
tion and Bump on instead. You'll want to
add a gradient to give the fresnel effect
on the Reflection channel; you can also
choose to copy the UV map used for the
Specular into the Reflection channel if
you like. (Image_05). One thing to make
sure of, though, is that the Reflection for
the skin is set to a lower value than that
of the eyes and fingernails (as these are
shinier). If you want, you can always copy
the eyes out to a second object layer, and
do those separately for full control, but
it's not totally necessary.

This time when we render, we'll want
to activate the Ray Traced Reflection
option in the Render panel, and turn the
Recursion Limit down to 2 to help keep

IMAGE 7- THE AMBIENCE PASS RENDERED

LIGBHTWAVE TUTORIAL

IMAGE 6- THE REFLECTION PASS RENDERED

the render relatively speedy. You should
get this. (Image_06)

Time for the last one, the Ambience pass.
Using the original model as our subject, get
rid of all the lights in the scene (and turn off
the last one that refuses to leave), and turn
up the Ambience in Global lllumination to
100%. Render. Obviously, this is our result.
(Image_07)

Of course, lastly we go back and render
off one pass for the background objects,
by hiding the foreground ones. Like so.
(Image_08)

Time now to crack open the compositor.
I'm still using After Effects, and you'll find

the AEP in the resource file, but you can do
this in absolutely any compositor you like.
You can do it in Photoshop too, you just
don't get as much final control due to the
lack of a precompose option.

First, the neatest trick. It's so obvious, |
bet you'd never have thought of it. Load
up the images you rendered, and drag the
Ambience pass into a new composition.
Above it drag the Occlusion pass, and set
its Transfer Mode to Multiply. Bingo. A
perfectly shaded render. (Image_09) Hang
on though; this is pretty much what we'd
get normally (ie. No MPR), isn't it?

Well, yes, but look at our options now.
Firstly, you can alter its Opacity, allowing
through more Ambience, and lightening
the shadows. But wait, you can also copy
the Occlusion layer and add it again (or
play with its levels) to darken, or harshen
the shadows. Or you can set it to be over-
laid, or hard light. Now do you start to see
some of the possibilities, and that's only
using two passes? (Image_10)

IMAGE 8- THE BACKGROUND AND TV LAYERS
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MPR FOR LIGHTWAVE
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IMAGE 12- A SECOND COPY OF THE REFLECTION
IS ADDED
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IMAGE 13- THE SPECULAR PASS IS ADDED

Now create a new composition using the
Reflection pass. Again, dump the Occlusion
pass on top of this layer. I'm wanting to use
the Occlusion pass to give more contrast
to the reflection. | could just play with the
levels, but this is far more useful. To do this,
set the Occlusion layer’s Transfer Mode to
Overlay. See the subtle difference?

Drag this new reflection composition
back on top of the two layers in our first
composition. Right-click on it and choose
Effect>Fast blur, and give it a minor blurring
of 1or 2 pixels. Finally, set its Transfer Mode
to Add. I find this a bit bright, so | turn its
Opacity down to 50%. (Image_ 11). Looks

|

IMAGE14- THE SUBTLE DIFFERENCES BETWEEN A
NORMAL RENDER AND MPR

nice, but | want to make those highlights
ping just a little more. | copy and paste the
reflection comp again, but this time add
to it an extreme levels adjustment, and a
Hue/Saturation effect, to desaturate it and
remove the color. The Opacity can be toned
down to around 40%, and I've also changed
the Transfer Mode to Screen. (Image_12)

Once you've got this set up, you can
go back to the reflection composition, and
play around with it if desired, change the
Transfer Mode on its Occlusion pass and
so forth to further fine tune the reflection,
and it'll update the main composition as
you go. There's that control thing again.

OK, so now we can add the Specular pass.
Drag it into the main composition, position it
below the reflection layers, and set its Mode
to Add. | find it looks good just like this.
Maybe | want to brighten it a little, and maybe
introcluce some color into the highlights, so |
add another copy of the Specular pass, give
it an extreme levels adjustment again, adjust
the color balance to turn it a little yellow, and
finally blur it off about 4 pixels or so. Again, |
set this to Screen, and down to 22% Opacity
to soften it down some. (Image_13)
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IMAGE 15— THE VARIOUS EFFECTS ACHIEVED BY CHANGING THE TRANSFER MODE OF THE OCCLUSION PASS

Lastly, add to the very top the normal
diffuse render. By toggling the Visibility
on and off, you can see the difference in
look achieved through MPR. True enough
this look could have been achieved in
LightWave, but it would have taken far
longer to mess around with surface and
light settings, not to mention all that added
render time. (Image_14)

The interesting thing here is that all this is
much more irrelevant for pure CG work like
our image here. Where techniques like this
really come in useful is with visual effects
work, like our dinosaur from the last issue
of KeyFrame. Working with multiple passes
allows us to get far better matches when
compositing CG elements onto live action
backdrops. It lets us easily match things
like shadow darkness and color, specular
burn out and blurring, and so on. Now that
you've got a handle on creating alternate
scenes and models to get multiple passes,
I'm going to show you one or two more
small tricks that come in useful in other
situations that involve MPR techniques.

This first one is also pretty obvious
- relighting. How much time can you spend

IMAGE16- THE TWO VERSIONS OF THE RENDER

playing around with lights at different in-
tensities and colors trying to get something
looking just so? Try rendering off a few
different passes of your regular model, but
this time, do a different render for each light
instead of each surface element. Do also an
Occlusion and Ambience render, and you'll
get full control of your scenes lighting in
post. Place the Ambience and Occlusion
in a pre-composition, then mix your lights
in the main composition by varying their

opacities and color balances. Finally, blend
the Ambience/Occlusion layer over the
top and quickly and easily experiment with
hundreds of different looks. (Image_15)

But wait, that's not all. Here's a small
trick for adjusting reflections in post. No
doubt most of you will be familiar with
the fresnel effect, which causes a reflec-
tive surface to have varying degrees of
reflection intensity depending on the
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IMAGE 17- THE FRESNEL COLOR SETTINGS

viewing angle. Well, you can set it up
in keeping with perfect physics, but in
3D we usually need to circumnavigate
reality a bit to get things looking nice.
Take any object that you want to add
a fresnel effect to, and render off two
versions. (Image 16) The first should
be fully reflective, the second should
be colored pure black, with the fresnel
gradient in its Color channel so as it
becomes white at glancing angles.

BY AKIKO ASHLEY

T Bl
IMAGE 18- THE RESULT FROM COMPOSING
THEM IN POST

—— S

(Image_17) Back in your compositor,
multiply the black and white image over
the top of the reflection pass, and by

altering its Opacity and Contrast, you can
control the fresnel in post. (Image 18)

Well, | could go on, showing you
countless ways to combine different
passes in different ways to help out in
a whole heap of different situations, but
space is running short, and I'm sure that
the techniques discussed here will give
you more than a decent sized platform to
start incorporating Multi-Pass Rendering
into your own work. &

C.S. MONINS ISA3DARTIST,
AND INDEPENDENT FILM-
MAKER FROM THE UK. HIS
PERSONAL ANTICS AS
WELL AS MUCH ABOUT HIS
PERSONAL LIFE) CAN BE
FOUND ON HIS WEBSITE AT
WWW.REBELHILL.NET

GOD SAVE THE QUEEN

WHAT YOU GET IS EVEN
MORE THAN WHAT YOU SEE...
THIS MACHINE IS FAST!
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he IBM APRO
blows away everything in the
IntelliStation line
before it. This is a monster fast machine

IntelliStation
that came

with the fastest processor on the planet.
The IBM IntelliStation APRO in this
review features a super fast, dual 64-bit
Opteron 2.2 processor, 2 gigs of RAM,
and a smoking NVIDIA Quadro FX 3000
card. This 64-bit chip runs both 64-bit
and 32-bit apps, giving you the ability to
migrate to 64-bit without losing support
for your applications.

One of the technologies that makes the
AMD Opteron so fastis the HyperTransport
Bus technology. HyperTransport is a point-




to-point link architecture designed for high
bandwidth and low latency between inte-
grated circuits. HyperTransport links the
processors and chipsets on the mother-
board and provides speed of up to
19.2 GBs of bandwidth per proces-
gives the chip the ability
to be scalable. The Opteron chip has
larger onboard cache than other models,
which makes rendering on this machine so

sor. It

much faster.

Good examples of this rendering capa-
bility are the rendering results we have
had from different software packages.
For example, we modeled a character in
LightWave3D and animated her in Mes-
siah Studio using two machines. One
of the machines was a Dual Xeon 3.06
processor top of the line workstation
with the same setup as the dual Opteron
APRO. We were using Windows XP
Professional on both machines, which
customizes to deliver a much more
stable environment in which to run your
software. The exact same software is on
both machines.

Here are some of the amazing resulits.

We rendered the character on both
boxes in Messiah Render. The animation
was a sexy walk cycle on both machines.
Oddly enough, loading the file on the
Dual Xeon made the machine crash. We
decided to reload it just in case it might
be beginner's luck. Nope, it crashed
loading the scene again.

On the other hand, the APRO dual
Opteron was a breeze without any
problems. We started our rendering
tests. Immediate results from rendering
individual frames told us that the dual
Opteron APRO was killing the Dual Xeon
with rendering speeds up to 50 percent
faster. Frames on the Dual Xeon were
taking 70 seconds to render and only
45 seconds on the dual Opteron APRO.
At times, we were even seeing twice
the speed on the APRO. We swapped
the files on both machines to make sure
software corruption could not be blamed
on tainting the results. We got the same

results. The dual Opteron APRO was the
king of rendering in this test.

Animation is another test we decided
to run just to get a feel of both boxes
while working on projects. This is an in-
teresting fact to share; the Dual Xeon fan
came on four times as much as the fan
on the dual Opteron APRO, and the Dual
Xeon crashed six times while the APRO
stayed completely stable. We even tried
another Dual Xeon to make sure this was
not a fluke. Same results.

Project Messiah does not write any
software to take advantage of either
processor, so this was a pretty fair test.
We did other animation and rendering
tests and got the same results. In fact, we
even did a motion capture test and had so
many crashes on the Dual Xeon that we
had to stop using it for motion capture
tests. We used Messiah Studio for these
tests to demonstrate how necessary it
is to understand that stability issues are
both hardware and software related.

You have to give it to IBM for creat-
ing a top-notch workstation that takes
advantage of the power of the AMD
Opteron chip and delivers it in a slim
case that looks great in any office or
studio. What is even more amazing is
the AMD solution is also a much more
cost-effective solution to the Intel Xeon
solution with the same configurations.
In other words, consider the AMD box
over the Intel box if you want a killer
power solution that is both blazing fast
and cost-effective. IBM does a great job
customizing Windows to give you the
additional stability to run your apps. IBM
provides a three-year on-site warranty
that is very valuable in production en-
vironments where time is money. What
else can | say? The AMD box is the right
solution all the way across the board. In-
side every 64-bit Opteron workstation is
a superhero’s power waiting to get out.

The IBM APRO comes with several
configurations:

— AMD Opteron Processors 2.2 Ghz (1 or 2)

— Windows Professional XP or Red Hat
Enterprise Linux WS 3 Standard (AMD 64)

— GAMB NVIDIA Quadro FX 1100 to 256MB
NVIDIA Quadro FX 3000 cards

— AGP 8X graphics port.
— 6 (5) PCl slots

— Gigabyte Ethernet (integrated)

— 1Gig to 2 Gigs of PC 3200 DDR SDRAM
(with ability to go to 16GB)

— 36.4 GB Ultra 320 SCSI 10,000 drive
— CD-ROM 48 Max to CD-RW/DVD-ROM
Combination 48X/24X/48X/16X Max

— PricesRangefrom $2619.00to $6419.00at
IBM's preconfigured machines at their
Web site at www.ibm.com.

For more information about IBM, go to
www.ibm.com, and for more information
about AMD and the Opteron chip, go to
www.amd.com. @
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| RIGGING A VIDEO GAME 3
. CHARACTER USING THE
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haracter rigging can be a difficult

and frustrating task to 3D artists

of all levels. Developing a stable,
efficient rig takes knowledge, practice,
and common sense. This article is de-
signed to help further your knowledge
of rigging, and assumes you have a basic
understanding of concepts such as joint
chains, IK and skinning. We'll be using
Maya for all of our examples, but the top-
ics discussed can be applied in almost all
3D software packages.

HDRT 3D ISSUET
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I'm going to talk about the rigging
methods that | use that work for me. We'll
use a golfer character to illustrate our
ideas, starting from scratch and working
towards a fully rigged character. There is
almost always more than one way to do
anything in 3D, so just because | like to
do something one way doesn’t mean it's
the only way to do that particular task.
Having an open mind about new 3D tech-
niques and being able to think “outside
the box" will help you grow immensely as
a digital artist.

|

There are many qualities that a good
rig has, but the main concepts | want to
address are good naming conventions,
fast speed, stability, pick ability, and zero
ability. We'll also talk about how to cor-
rectly draw skeletal joints at odd angles,
get good deformations quickly, and set
up a curve-based rig that will act as a
simple, intuitive control structure for our
character.

When something breaks, and you can’t
tell what it is by looking at its name, you'll




have a harder time finding and fixing it. By
naming your nodes well, you can avoid
many problems and help ensure you
always know what part of the body you're
working with. | use a naming convention
that allows me to tell what type of node
something is, its description, orientation
and iterations.

TYPE_description_orientation_iteration
Examples:

JT_index_R_1 = first joint of the right index
finger
CTL_head = controller for the head

PS_golfer = golfer polygon geometry

When we talk about a “fast” rig, we're
talking about how heavily its network of
interconnected nodes affects your playback
speed and interactive manipulation. A slow
rig will chug along at a slow frame rate,
thus slowing down your workflow. Most
3D software these days can deal with fairly
complex rigs and models and still play back
in real time, but going overboard with a
huge cloth simulation or super-dense model
can slow things down to the speed of mo-
lasses. If you do need an effect as complex
as the ones above, make sure you give
yourself a way of hiding it if it's not needed.
One common trick is to create pieces of
low-res geometry from your high-res mesh
and parent them to their respective bones.
Once this is done, a switch is created that
toggles the visibility of the low-res/high-res
model, so that an animator can see the
shape of their character without having to

sacrifice speed.

So you've got a fast rig, eh? So fast that
you're almost done with your animation!
Until ... your character explodes. Stability
is a simple theory; your rig should not fall
apart when animated. Ensuring stability
in your rig is best learned through trial
and error, but you can avoid some com-
mon problems by planning ahead. Think
about how you're going to rig your char-
acter before you dive in. For the golfer,
I thought about how his golf club would
have to work with his hands, and vice
versa. Analyzing this complex relation-

ship helped me pre-visualize roadblocks
and solve puzzles before they became
problems. Another part of stability is
knowing what works and what doesn't.
As you become familiar with rigging, you
will probably develop a workflow that you
will use to set up most of your characters.
If a technique works for you, use it. If
not, don't bother. You don’t have to use
IK to make a great animation if you don’t
need it!

Pick ability refers to being able to easily
select different parts of the body without
a problem. Too much clutter or poorly
designed controllers will be confusing
when you're trying to tell the difference
between your character’'s neck and wrist
controls. One technique | like is using
curves shaped like icons, such as arrows
and cubes, as control objects. In addition,
try to make sure that things you don’t want
to accidentally select are hidden and have
their channels locked. Zero ability is an
often overlooked but important concept. If
you select all of your character’s controls
and “zero” each attribute, your character
should return to the pose at which is was
bound. This allows you to return to the
bind pose if you need to in order to fix
something that requires you to do so.

Our golfer is a biped, so we know what
kind of skeleton he'll need right off the
bat (fig_golferModel). Before we start
placing joints, we'll draw some curves in
the side and front views that approximate
the shape of his skeleton. Use a 3-degree
CV curve for the spine and neck, and 1-
degree linear curves for the arms and legs
(fig_skeletalCurves). We're dealing with a
photoreal human, so we should pay atten-
tion to anatomy here, as we don’'t want
to stray far from the shape of an actual
human skeleton. The completed curves
not only give us a great pre-visualization
of what our skeleton will look like, but also
allow us to use Maya's Snap to Curves fea-
ture (fig_snaplcon), giving us the ability to
draw our joints in perspective view right
on the curves. This is especially helpful in
drawing the arm joints, which are bent at
an odd angle. Drawing them on curves
will ensure that their orientations line up

MAYA
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FIG GOLFERMODEL BIPED GOLFER

FIG_SKELETALCURVES - WIRE FRAME WITH CURVES
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Snap to curves

FIG_SNAPICON - MAYA'S SNAP TO CURVES ICON
J
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correctly and that the bones are pointing
in the right direction. You'll want to draw
the spine and each limb separately (draw
the limbs for one side only, we'll mirror
them later), and name each joint with a
“JT_" followed by a description of its loca-
tion and orientation, such as “JT_spine_1"
and “JT_arm_R". See (fig_spinejoints)
(fig_leg_hierarchy) and (fig_armjoints) for
how our spine, legs, and arm joints look.
I've used a 4-bone spine, which will work
fine for this game-res character. We're go-
ing for photoreal here, but we don't need
to replicate all of the joints of the human
spine. Note that I've drawn an extra joint
at the midpoint of the upper and lower
arms (fig_arm_hierarchy). These joints are
there to help out the twisting motion in
the shoulder and wrist areas. By animating
the X rotation (twist) on these bones and
tapering the weight maps between neigh-
boring coaxial bones, we can achieve a
gradual twist deformation in these areas,
rather than a sharp twist at the shoulder
and wrist. Once we make controllers for
our character, we can use the Connection
Editor to have one controller drive the ver-
tical and horizontal motion in the shoulder
and the twist in the bicep.

FIG_SPINEJOINTS FIG_LEG_HIERARCHY

To draw the fingers, I'll use a technique
similar to the curve-based one, but with
planes instead. Create a NURBS plane and 3 N e iy T =
line it up so that it bisects the finger along its FIG_ARMJOINTS FIG_ARM_HIERARCHY
primary axis of movement (fig_fingerPlane,
fig_fingerPlane_bisect). Make the plane live
using the magnet icon in Maya's status bar
(fig_makeLive_icon). Now, if you draw a joint
in perspective view, it will snap to the plane
(fig_fingerPlane_bisect_makeLive) We can
use this to easily draw finger joints in an area
that would be otherwise difficult. When using
this method, it helps to first draw a “dummy”
joint off to the side of the finger (but still on
the plane), and then continue to draw the
joints of the chain. Un-parent the first “real”
joint from the “dummy” joint and delete
the dummy (fig_fingerPlane_dummy_joint).
Placing this first throwaway joint helps orient
the next joint correctly when using this help-
ful method. Once you've completed a finger,
click the magnet icon again to make the
plane unlive. Repeat for the rest of the digits,
until you have a complete hand skeleton.

FIG_FINGERPLANE FIG_FINGERPLANE_BISECT
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FIG_FINGERPLANE_BISECT_MAKELIVE

L

FIG_FINGERPLANE_DUMMY_JOINT

FIG_CLAVICLE_JOINT

FIG_ROOTJOINT

FIG_PAINTSKIN_HEAD

MAYA TUTORIAL

Create a single shoulder joint (not a full bone,
just a joint in space) and position it near the
character’s spine, slightly below where the
arm starts (fig_clavicle_joint).

You can also create a hip joint below your
character’s spine, which will give you more
control over your character’s pelvis (fig_hip-
Joints). Parent both the first spine joint and
the hip joint to a central joint, which will be
your character’s root (fig_rootfoint). Parent
the fingers to the wrist, the arm to the
shoulder to the upper spine, and the legs
to the hips. Mirror the limbs to the other
side using Skeleton>Mirror Joint). Maya 5's
Mirror Joint function allows you to search
and replace parts of your hierarchy names
for the mirrored side, so you don’t have to
type “_L" over and over.

Now that we have our skeleton, it's time
to bind our geometry to it. We'l use a
Smooth Bind, which will allow us to use the
Paint Weights tool later. Select all of your
character's geometry, shift select the root,
and go to the Skin>Bind Skin>Smooth Bind
option box. Leave the settings at default,
except for Max Influences, which we'll set at
1. This will skin each point directly to its clos-
est bone, creating areas of full influence now
that we'll smooth out later. We'll start with
the head and work our way down the torso,
using the Paint Skin Weights tool (Skin>Edlit
Smooth Skin>Paint Skin Weights Tool) to
block solid areas of full weight for each bone
(fig_paintSkin_head)  (fig_paintSkin_neck).
Paint the limbs on one side only, as we'll

FIG_PAINTSKIN_NECK
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FIG_PAINTSKIN_TORSOBEND

FIG_PAINTSKIN_SPINE

mirror the skin weights later on. Make sure
you are using the “Add” option under Paint
Operation and that the value is set to one.
You can interactively change your brush size
while painting by holding the B key and left-
click dragging with your mouse.

Many people wait until their character
is completely set up before they animate
truth, animating your
character while skinning is a great way
to speed up your workflow! By quickly
doing some simple bending and twisting
animations with your character, you can
see how the deformations look while
he's in action (fig_paintSkin_torsoBend).
You can also paint weights while your
character is in problem-causing poses,
which can fix nasty deformations very
quickly.

anything. In
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Once we've got the skinning looking
good (on one side of the body, at least),
it's time to go back in and blend the
weights between different areas. Using
Paint Weights, set your Paint Operation
to add and paint some additional weight
from neighboring bones on your maps
(fig_paintSkin_spine). This is better than
using the Smooth function, which tends to
smooth the weights out across the whole
skeleton, resulting in messy super small
influences on unwanted body parts. Clean
up your work, and use Maya's Mirror Skin
Weights tool to flip the weight to the other
side. Make sure your character is in the
bind pose when you do so, or the mirror
operation may not work correctly.

At this point, we should have a fully
functioning golfer with good deforma-

tions. Don't worry if the skinning isn’t
as good as it could be, as we can always
go back and paint weights during the
animation process. Now it's time to build
the control structure that we’ll use when
we're animating. Now is a good time to
think about the actions your character
will need to perform during your ani-
mation, which can help you determine
whether or not to use FK or IK.

Forward kinematics, or FK, is based on
the idea of rotating bones. You select
your bone, rotate it, key it, and move on
to the next one. The concept is much like
that of a sock puppet, where you rotate
your wrist and forearm to drive your
character’s motions (fig_FK_example). In
most situations, this is the best way to
go, as it gives you precise control over
each joint’s rotations and allows you to
really fine tune your motions. However,
when you need the end of a limb to stay
still while the rest of the body moves, FK
can be a real nightmare. A good example
of this is a walk cycle, where your charac-
ter’'s feet need to stay in contact with the
ground while the body moves forward.
This is where IK comes in, as it allows au-
tomatically driving a joint chain by mov-
ing a target, called an IK effector. If the
rest of the body moves, the foot will stay
planted until the effector is moved. This
is like working with a marionette, where
the strings attached to the hands and feet
cause the limbs to bend (fig_IK_example).
Both FK and IK can work well in different
situations, and a good rigger will often
find ways of incorporating both into a rig,
allowing the animator to choose which
one to use. We'll draw a simple IK system
on each leg. Using the IK handle tool
(make sure it is set to rotate plane instead
of single chain), click on the first joint in
the leg, then the ankle. Draw a second IK
chain from the ankle to the toe.

What we have now is a low-level character
rig that gives us a basic level of control for
our character. We have everything we need
in order to animate a basic walk: bones that
our character is skinned to, and IK chains
for the legs. While we could go ahead and
start setting keys, it might be a good idea




to consider developing the rig a bit further.
Investing a bit more time into this will allow
us to create a rig that will be more stable,
fixable, and flexible than what we have now.
Let's start with creating controllers, which
are the nodes we'll select when we want to
work with different parts of the body.

We'll use curve-based controllers (rather
than locators) to drive the motion of our FK
bones and IK systems. As | stated before,
iconographic curves are more easily identi-
fied and selected than locators. | usually try
to use simple geometric shapes that can be
easily identified and selected for my control-
lers. Circles, squares, and arrows work just
fine, and can all be easily drawn with the CV
curve tool. After creating a control shape,
name it “CTL_," followed by a description
of its purpose and orientation, such as
“CTL_spine_1." Group it by itself (Ctrl + G) to
create another pivot, and use Maya's snap-
ping function, or a snapping script, to move
and align the group to the first spine joint.
Parent the group to the parent of that joint,
so that the controller and spine_1 joint exist
in the same local space and share similar
orientation. If the curve doesn't line up the
way you want, select its points and move
and rotate them into the shape you want,
which won't affect the controller’s position
(fig_example_spineController).

We can now use Maya's Connection
Editor (Window>General Editors>Connection
Ediitor) to create a direct relationship between
the curve controller’s rotations and the joint's
rotations. Load the controller into the left
window and the joint into the right, and
select rotation for the controller and the joint
(fig_connection_edi). For the legs, we'll make
arrow-shaped foot controllers and parent the
IK chains to the controllers. We'll also add a
“pole vector” controller, which will allow us
to control the orientation of the knee. Place
the controller directly in front of the knee,
shift-select the leg to ankle IK, and go to
Constrain>Pole Vector. Parent the controller
to the foot controller, and repeat for the
other side. Our rig is almost finished; see fig
(fig_rigFinshed) for how our curve control
structure looks.

Let’s finish off the rig with some finger

MAYA TUTDRIAL

FIG_RIGFINISHED

controls. Make another curve controller, and
place it slightly above the hand. Using Ma-
ya's Add Attribute command (Modify>Add
Attribute), add the following float attributes,
each with a min, max and default of -10 10
and 0: index, middle, ring, pinky and thumb.
Parent the control to the wrist joint, and use
Maya's Set Driven Key to wire the finger
rotations to the attributes. This enables us to
quickly pose the hand using one controller,
without having to wade through a mess of
joints (fig_fingerControl).

We now have a simple and effective rig
for our character that can be reused for
multiple animation projects. Additional
controls for the face, club, and eyes can
be added to help bring further life to out
character. We can now quickly pose our
character and start blocking out our anima-

tion (fig_golferPosed). Our controls are
zero able, so if we need to return him to
the bind pose, we just need to zero out all
our animatable attributes.
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Here are some additional pointers that the animation of one attribute
you can use to enhance your workflow: is driven by the animation
of another. A great exam-

Think about how you can use hierar- ple is using Set Driven Key |
chies when you animate. By creating a to control finger animation
multi-level hierarchy with different con- with custom attributes. Set
trollers, you can separate different aspects Driven Key, the Connection
of your movement onto different layers, Editor, and the Expression

allowing you to control the motion more Editor are powerful tools that
precisely. You could have a layer that you can use to build automated
controls rotation parented to a layer that relationships between nodes.
controls translation.
Here's a really quick
If you're doing facial animation, consider shortcut that can help you
creating a camera that aims directly at your when you're animating.
character's face. Parent the camera to your Click in the timeline with
character’s head joint, and look through it the left mouse button, and
when you need to look closely at the face you'll move to that frame

while animating. and the animation will
update. Click the middle

Learn how constraints work and incor- mouse button and you'll
porate them into your rigs. Point, orient, move to that frame ... but

and aim constraints are a valuable tool in the animation won’t update.
your rigging arsenal. Keep in mind that an Confused? Think of it as a way

object can have multiple constraint targets, to travel backwards and for-
and that the weights of the targets can be wards in time, without having
animated. the animation move with you.

The best part? If you set a
Character sets are shapeless nodes that key on whatever you have
are a collection of all of your character’s selected, it will create a
animatable attributes. When you create key with the displayed
a character set (Character>Create Char- value intact. @
acter Set), you define a set of nodes and
attributes that you want consolidated
into the set. You can make the character
set active by using the dropdown menu

to the right of the range slider. When
the character set is NOT active, press-
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Building from Images with Modo

AN INTRODUCTORY

TUTORIAL

FIGURE 1- THE DEFAULT MODO INTERFACE.

fter two long years, Luxology, Inc. has released their first
product, modo. It is a highly anticipated 3D modeling
application that is one of the most advanced polygonal and
subdivision surface modeling tools ever created. Aside from having
one of the most flexible and easy to use interfaces on the market,
modo has a very clean and easy workflow. We'll be adding modo tu-
torials in future issues of HDRI 3D, so be sure to check them out. But
instead of talking about this program, we thought we'd include an
introductory tutorial so you can see just how this program works. [:;ﬁ

You'll start this tutorial in a default modo layout. Modo gives you

the ability to create any possible layout arrangement you can think of,
and access it at a_nyt]me I've been able to set it up on a dual-screen FIGURE 2- MODO ALLOWS YOU TO BUILD OBJECTS WITH CURVES.

system with a quad view and tools in one monitor, while the other SELECT THE CURVES TOOL AFTER FIRST CHOOSING THE CURVES PANEL

monitor has just a full frame perspective view. Figure [shows a default
layout when modo is started.

You can change the arrangement of panels and views to anything
you like. Modo may default to a single perspective view; if so, change it
to a quad view from the top right of the panel.

At the top left of the modo interface you'll find the modo Tools

list. Modo allows you to create with primitives, points, or curves,
as you would with most modelers. Click the Curve button to change
the modo Tools to Curve options. This is the tall vertical list of tools
lined up to the left of the top viewport. Once you click curves, select
the Curve tool, as shown in figure 2. You can see that you have the
option of using Bezier, Sketch, or a Tube option.

FIGURE 3- QUICKLY ADD A BACKDROP IMAGE IN MODO FROM THE

VIEWPORT DISPLAY OPTIONS
Modo allows you to use colored backdrop images for reference to
reate 3D models. In the bottom left viewport, click on the viewport
display icon, which is the second label at the top left of each viewport. COOL TIP: Another easy and cool way to add images
Once the options appear, go down to the Backdrop option and choose to your backdrops in modo is to simply drag and drop them
Load Image, as in figure 3on the next page. Load the oldwheel.jpg im- from another directory on your system.

age from 3dgarage.com/downloads, or use one of your own.
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BUILDING FROM IMAGES...

With the image loaded in the backdrop, go to View at the top of
modo and choose Adjust Backdrop Image. On the lower left of
modo, you'll see the Backdrop Image Controls appear, as in figure 4.

One thing that's cool with these tools is that you can interac-
4 tively adjust the image. Click directly on the image and you'll
see a bounding region appear. Click and drag a corner to size the
image. Click in the center to move around, and use the Ctrl key
to constrain movements. You can also set the Display Resolution
depending on the strength of your video card. Conversely, you can
click and drag on the sliders in the backdrop for properties to ro-
tate, set Transparency levels, and more. Experiment! When ready,
set Transparency to 50%. Press the spacebar to drop the tool.

Move your mouse cursor over the backdrop image and
press O on your numeric keypad. This will make the view
full screen. Then, press a to fit it to view.

From the Basic tool set, choose the Cylinder tool, as shown in
figure 5,

In the viewport, hold the Ctrl key and drag out a disc over the
7image. If you have trouble seeing the geometry, simply go
to View at the top of modo, and choose Adjust Backdrop Image
— then change the Transparency. Once you draw out the cylinder
shape, you'll see that it's a bit chunky. Don't drop the tool yet, and
in the Tool properties on the left, up the sides to 50.

Once the cylinder is to your liking, press the spacebar to
drop the tool.

9Pr&ss 0 on your numeric keypad to return to a quad view.

10 You'll see that because you created a cylinder, it's extended
out down the Z-axis. Press the spacebar a few times so that
you bring modo to Edges mode (shown at the top of the viewports).
Then, with the right mouse button, lasso select around eight rows
of polygons, as shown in figure 6.

1 With the rows of the object selected, simply press the
delete key on your keyboard to remove them.

1 Now here's a cool feature — in the Perspective view (top

right), add the backdrop image to the background, and
size it up accordingly to match your original placement in the
bottom left view. To figure out what size your other image is,
go to View at the top of modo, and choose Adjust Backdrop
Images. Then, click on the image in the front view — look at
the tool properties on the left. Note the size. Then, click on the
image in the Perspective view, and enter the same size value.
Next, press the spacebar to jump to Polygon mode, and then
in the top right viewport, select the front of the disc. Figure 7
shows the image now in Perspective view.
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FIGURE 4- BACKDROP IMAGES HAVE ALOT OF CONTROL IN MODO
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FIGURE 6- EDGE TOOLS AND SELECTIONS ARE ONE OF MODO'S
STRONG POINTS, AND IT'S EASY TO QUICKLY SELECT AND REMOVE
UNWANTED GEOMETRY




MODO TUTORIAL

COOL TIP: When adjusting backdrop images, you

can change the way the image is projected. Notice in the
Backdrop Image tool properties panel, you can change
projection to front, right, top, bottom, and so on.

1 Change the Perspective view to Wireframe view. Make sure

the first polygon on the disc is selected (be sure you're in
Polygon mode at the top of modo). Then press the b key to activate
the Bevel tool, as in figure 8.

1 When you're working in Bevel mode (or any other),

clicking on the selection brings up handles. Click the blue

== 5 handle in this case to shift the bevel, and the red handle to inset.

FIGURE 7- YOU CAN ADD AN IMAGE TOA PERSPEC]lIVE Bevel the selection to match the background image so that you
VIEW FOR ADDED MODELING REFERENCE create the first edge of the wheel.

20 cm

Rk Weraframe w1y

1 Next, press b to turn off the tool, then press b to turn it
on again. Now bevel the same selection inward. Figure 8b
shows the operations.

1 6Now repeat the above steps a few more times so that
you continue beveling, using the backdrop images as
guides. Figure 9 shows the results.

1 Save your work by pressing Ctrl-S. Then, press to set a
7material name for the wheel. Enter something original like,
“wheel.” To set a color, you can simply click and drag on the values,
or click once to call up your system'’s Color Corrector. Give it a bit of
Specularity and you're good to go.

18At the top of modo is the Material dropdown. Select this to
- choose Material Editor, as shown in figure 0.

FIGURE 8- BEVELING IS JUST ONE WAY TO BEGIN CREATING SHAPES

FROM PRIMITIVES

19In this panel, you can adjust and assign various materials to
your models.

FIGURE 8B-AFTER TWO BEVELS, YOU CAN BEGIN TO SEE THE FIGURE 9- YOU CAN ADD AN IMAGE TO A PERSPECTIVE VIEW FOR
SIMPLE DISC TAKING SHAPE ADDED MODELING REFERENCE
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BUILOING FROM IMAGES...

2 At the top of the Material Editor you'll see M, T, | = M
Ofor material, meaning the material name you're work-
ing with. In this case, you've only created one single material,
wheel. If you had more, you could choose them from the drop-
down list. The T is for a new Texture, and | for Image. Select T,
and from the dropdown to the right, choose New Texture. Load
the oldwheel.jpg image, or the image you used for the wheel
reference. Click OK, and you'll see the image mapped on the
wheel as in figure [1.

2 Close the Material Editor, and in the Perspective view, you

can click and drag on the red and green handles to easily
adjust the size of the image to line up with your model. Click and
drag the light blue handle to move the image. Figure 12 shows the
placement in the Perspective view.

2 From the viewport render style selection, you can change
the shade options to not show wireframes, making your
image map easier to see. Figure 13 shows the selection.

The next step would be to build out the tire itself, and join it
with the wheel. You can do this using a combination of bevels,
either on the polygons or the edges. Additionally, you can try
building with the Lathe tool from a simple curve. Try creating
a curve by going to the Curve panel (the tall vertical panel to
the right of the tools) and then, using either just Curve or Bezier
Curve, build the shape of a tire. Then use the Lathe command.

But there are multiple ways to build objects in modo. This tutorial
was about as basic as you can get, but it can give you an under-
standing of the workflow and interface. Our future tutorials will
really get into modo deeper, through the use of edges, subdivision
surfaces, use of the modo tool pipe and so much more. Please send
your modo suggestions to us so we can create the tutorials you
want. Until then, happy modeling! &

DAN ABLAN IS PRESIDENT OF AGADIGITAL STUDIOS, INC. IN
CHICAGO, IL., AND FOUNDER OF 3DGARAGE.COM. HE HAS
WRITTEN EIGHT BOOKS FOR NEW RIDERS PUBLISHING ON
3D AND COMPUTER GRAPHICS, AND HAS RECENTLY PUB-
LISHED LIGHTWAVE [8]: KILLER TIPS (WITH RANDY SHARP).
DAN HAS CREATED A 20 HOUR LIGHTWAVE COURSE ON
CD-ROM, YOU CAN FIND OUT MORE ABOUT THE COURSE
AT 3DGARAGE.COM. DAN IS ALSO THE EDITOR-IN-CHIEF OF
HDRI 3D MAGAZINE.
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FIGURE 10- THE MATERIAL EDITOR FIGURE 11- THE MATERIAL EDITOR
OFFERS UNIQUE CONTROL FOR ALLOWS YOU TO CREATE AN IMAGE
SURFACING AND TEXTURING MAP FOR THE COLOR, DIFFUSE,
YOUR OBJECTS SPECULARITY, AND
MORE FOR YOUR MODELS

FIGURE 12— ONCE AN IMAGE MAP IS APPLIED, YOU CAN
EASILY MANIPULATE IT IN MODO'S VIEWPORTS

FIGURE 13- VIEWPORT RENDER STYLES ARE WIDE RANGING.
HERE, YOU CAN SEE THAT THE VIEWPORT HAS A TEXTURE
VIEW VISIBLE, BUT THE WIREFRAMES CAN ALSO BE TURNED
ON OR OFF AT THE SAME TIME




BY KENNETH IBRAHIM

COMMANDING AN AUDIENCE:
THE MAYA API COMMAND PLUG-IN

API INTRODUCTION

interface that provides a great deal of convenience and power

to the Maya user. Daunting at first, many shy away from its
potential and speed and instead work exclusively with MEL to develop
the various tools needed for a project. The intent here is to take some of
the mystery out of the use of the APl and to demonstrate by example
what can be relatively easily accomplished. The APl provides access to
most of Maya's underlying data structures and offers many built-in data
manipulation methods, some of which appear in various MEL com-
mands and some of which don't. It also offers a vast speed improvement
(approximately 10x) over MEL, as API plug-ins are compiled rather than
interpreted and won't have the overhead many MEL commands do. Be-
cause plug-ins are compiled, another program called a “compiler” must
be used to create the plug-in from the source code. Compilers are free
software in the world of Linux (gcc being one I've used recently), but
Microsoft Visual Studio for Windows is rather costly, and I'm not sure
what the situation is on the Macintosh. This article doesn’t cover compil-
ers or the compilation process; rather, it describes the development of a
plug-in via its source code independent of the compilation environment.
The API provides for cross-platform compatibility, and getting a plug-in
developed on Linux to compile and run on Windows, for example, is
effortless. Very little change, if any, is required for the source code. The
Maya distribution ships with extensive APl documentation, including an
introduction, full C++ class descriptions, compiler issues, and a number
of examples. It also provides a growing FAQ section which clears up a
lot of development questions. | highly recommend familiarizing yourself
with that information.

T he Maya API (Application Programmer Interface) is a C++ based

The API allows for development of a number of different plug-in
types, including the following:

MEL Command—Implements new functionality with undo/redo
capability

Dependency Graph (DG) Node—Implements nodes that take
data as inputs and calculates new values for outputs

Locator Node—Same as DG node type with additional support
for OpenGL drawing into the Maya viewports

Shader Node—Implements shading nodes such as materials,
textures, eftc.

Shape Node—Implements new geometry types with selectable
and modifiable components

File Translator—Provides an interface to read and write proprietary
data via the File>Open/Save menus

Manipulator—Allows for custom manipulators to modify attributes
of node plugs

Deformer—Implements a new deformer type fully integrated into
the Maya architecture

In this example, we will develop a MEL command plug-in that will
work in conjunction with a small MEL wrapper script to improve user
workflow when using Maya Cloth constraints.

IMAGE 1- THE “INDEXLIST" VERTEX INDEXES DATAPLUG

THE COMMAND

I was working quite a bit with Maya Cloth on a certain project (involv-
ing a big green guy) in which | made heavy use of cloth constraints,
which are composed of particular sets of vertices. After having labori-
ously picked the points | wanted to use in the constraint, | would often
make the mistake of creating the constraint without first saving the set
of vertices as a Quick Select Set for later use. If | then needed to add
or remove vertices from the constraint, | was up against a painful task.
Even adding a single vertex to the constraint would involve deleting the
current constraint, reselecting all of the vertices | originally had plus the
additional vertex, and then creating the new constraint. With constraints
composed of a small, easily selected set of vertices this might be ac-
ceptable, but remembering which points were part of a densely packed
region was impossible. So | did a little investigating in the Hypergraph
and discovered that there is a certain connection between the constraint
shape node and the Cloth solver node called “indexList” (shown in Image
1) that sounded promising as a list of the vertices involved. Using the
getAttr command with the —type flag confirmed that the attribute was
an array of integers; the indexes to the vertices of the constrained cloth
mesh, | supposed. So | decided to create a command that would simply
pass back the list of constrained vertices that I could then deal with via
a simple MEL wrapper script to create the modified constraint. We'll see
the MEL script after discussing the plug-in code.

Each type of plug-in is based on a provided class and requires
certain methods (C++ functions) in the class to be overwritten. For a
command type plug-in, the base class is called MPxCommand and the
set of methods are as follows (those marked * are optional):

constructor—called when node is created
destructor—called when node is actually deleted

dolt—performs the actions of the command but often is used to
parse the argument list and then call redolt

redolt*—performs the actions of the command

undolt*—undoes the actions of the command

isUndoable*—determines if the command supports undo
creator—called when a new instance is instantiated

We'll describe each of these methods as we get to them in the
code.
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COMMANDING. ..

SOURCE CODE AND EXPLANATION

We begin by including all of the header files we'll need. This will
include the MFfnPlugin and MPxCommand headers for this type of plug-
in, as well as some of the other common headers, including MArgList
for retrieving the arguments passed to the plug-in. The MSelectionList,
MFnDagNode, MDagPath, and MPlug classes provide the mechanism to
extract the desired DAG objects from the Maya scene file. Because this
plug-in deals with arrays of integers (the vertex indexes), we call upon
the API's MFnintArrayData class to access this data.

#include <maya/MFnPlugin.h>
#include <maya/MPxCommand.h>
#include <maya/MArgList.h>
#include <maya/MFnDagNode.h>
#include <maya/MDagPath.h>
#include <maya/MPlug.h>

#include <maya/MSelectionList.h>
#include <maya/MFnintArrayData.h>

The next step is to create our command as a subclass of the MPx-
Command class.

class getCpConVerts : public MPxCommand
{

public:
getCpConVerts():
virtual ~getCpConVerts();
MStatus dolt(const MArgList &.args);
MStatus redolt();
static void “creator();
private:
MString conName;

As you can see, I've named the command getCpConVerts as a
contraction for “get cloth plug-in constraint vertices” and I've added
a single instance attribute called conName that I'll use to identify the
constraint. | haven't defined the isUndoable and undolt methods,
as | chose not to implement “undo” functionality for this example.
Although this command is not set to be “undoable,” I've gotten into
the practice of dividing the workload between the dolt and redolt
methods. Generally, you want to use the dolt method to parse any
argument list you might have and set any internal variables that will
be accessed later, and then call the redolt method to perform the
actual work. This puts the code into a good position to add “undo”
functionality later should you decide to take on the task via the undolt
method.

Next we define the constructor and destructor methods as well as
the creator method.

// constructor & destructor
getCpConVerts:getCpConVerts() {|
getCpConVerts:~getCpConVerts() (|

// creator
void "getCpConVerts::creator()
{

return new getCpConVerts;

:ﬁﬂ HDRI 3D 155UE1

There is no need to do anything in either the constructor or de-

structor methods other than to define them, and the creator method

simply returns a new instance of this command that, in this case, will
be destroyed immediately after execution, since we haven't defined
“undo” functionality.

MStatus getCpConVerts::dolt(const MArgList &.args)
{
MStatus status;

// retrieve the arguments
conName = args.asString(0, &.status);

status = redolt();
return status;

Our dolt method only does the groundwork of the command; it
parses the argument list and stores the resultant string into our in-
stance variable. The MArgList class provides convenience routines to
fetch indexed items from the list as specific types. Here I'm retrieving
the only argument we expect and interpreting it as a string. I don’t
error check the result as the front end MEL script makes sure that a
single, valid string is passed to the command. The status variable is
used to error check most other method invocations along the way,
printing out appropriate error messages at each step. Once we've
retrieved our parameter, the name of the cloth constraint we're inter-
ested in, we call the redolt method to perform the real work.

MStatus getCpConVerts:redolt()
{

MStatus status;

// put the surface on the selection list and retrieve the dep node
MSelectionList sList;

MODbject conObj;

MbDagPath conDagPath;

status = sList.add(conName);
if (Istatus) {status.perror(“adding constraint to sel list”); return
status;}

status = sList.getDagPath(0, conDagPath, conObj);
if (Istatus) {status.perror(“retrieving constraint from sel list");
return status;|

The first part of the method illustrates a very common procedure
for accessing an object in Maya from the APl when the object’s name,
as opposed to any of its attributes, is given. Since this is a command
plug-in, we don’t have any plugs (the pipes for making connections
between node attributes) to pole for data as we would with a node-
type plug-in. Instead we have the name of the node as a string. So what
we do is create an instance of a selection list via the MSelectionList
class and use the add method of the class to put the object on the list.
Wildcards can be used with this method, so you can add multiple items
at once if desired. Before going on, it's worthwhile noting that another
way to have written this plug-in is to have the user select the actual
cloth constraint node and then call the command without passing any
names. In that case, a “current” selection list would already exist and
we would then simply extract the selected item from the list. | chose
to write the plug-in with the parameter so that | would need to do less
error checking in the code with the idea in mind that any checking
and validation of the data would be done in the front end MEL script
that we'll look at shortly. The Maya APl documentation has some very
good examples of selection methods described under the “Selection”
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chapter, so be sure to check it out. It shows you how to iterate over
objects, select objects by name, etc.

// get handle to the “indexList” array attr
MFnDagNode nodeFn(conDagPath);
MPlug indexListPlug = nodeFn.findPlug(“indexList”, &status);
if (Istatus) [status.perror(“retrieving indexList attr plug”);
return status;|

Next, | retrieve the first and only element on the selection list via
the getDagPath method. | use this method to get a unique path to the
constraint DAG node, which I can then use to find the plug | want. To
accomplish this, | create an instance of an MFnDagNode object, initial-
izing it via the DAG node, path [ have in the conDagPath variable. Finally,
| fetch the plug of interest by name using the findPlug method of the
MPlug class, leaving me with the indexListPlug instance.

MObject indexListPlugObj;
status = indexListPlug.getValue(indexListPlugObj);
if (Istatus) [status.perror(‘retrieving indexList obj from
plug™); return status;}
// get handle to the attr array
MFnintArrayData indexListAttrArray(indexListPlugObj);

To get to the actual array of integers, | need to create an instance of
the MFnintArrayData class using a Mobject, which | produce using the
getValue method on the indexListPlug instance. I'm finally at the data |
want! Wheh!! Remember that | knew from the beginning that [ was deal-
ing with an array of integers and by searching through the alphabetical
API class listing, | found the MFnintArrayData class and figured that |
would eventually use it to access the real data. The rest of the code is
just the path to get there.

long numVerts = indexListAttrArray.length();

// return the array of int indexes to the vertices

MPxCommand::clearResult();

for(int i=0; i<numVerts; i++)
MPxCommand:appendToResult(indexListAttrArray[i]);

// return status
return status;

At last we get to the real heart of the code, which is simply a for
loop that returns all of the array data (the vertex indexes) to the user,
where it can be stored in a MEL variable or simply examined in the
Script Editor window. The mechanism to return data from a command
is the MPxCommand class’ appendToResult method. To be safe, | also
call the clearResult method to make sure I'm starting off with a clean
slate. As a note, if you're only going to return a single result as op-
posed to an array of data, you can use the setResult method. We
end the redolt method by returning the required status value as we
did for the dolt method, hopefully indicating success. This method
demonstrates a bit of the convoluted nature of the API, in which you
have to kind of onion peel your way to the actual data you want via
various classes and methods.

We complete the plug-in by defining the necessary initialize and
uninitialize routines. If you don'’t include these functions, the plug-in
will not load into Maya. The initialize function is used to register any
commands, nodes, devices, etc. that your plug-in provides. Likewise,
the uninitialize function de-registers anything that you registered
with the initialize function. Both of these routines can be either a C or
C++ function.

extern “C” MStatus initializePlugin(MObject obj)

{

i

extern “C" MStatus uninitializePlugin(MODbject obj)

{

il Plug i Barager o6
an instance of the MFnPlug-in class in E—— :
which we specify attributes that show up | | == === "== 1

& Phog 0 Indermation oar

when clicking on the info button next to the |&= i
plug-in name in the Plugin Manager win- [
dow as shown in Image Z. This information i

includes the vendor name (here my initials | “zz... f
“KALI"), the version, and the required API i
version. We then proceed to register the = !

command. When un-initializing, we simply
de-register the command. Here now is
the complete source code listing which is |_
also available online at www.hdri3d.com/

resources.
// INCLUDES
#include <maya/MFnPlugin.h>
#include <maya/MPxCommand.h>
#include <maya/MArgList.h>
#include <maya/MFnDagNode.h>
#include <maya/MDagPath.h>
#include <maya/MPlug.h>
#include <maya/MSelectionList.h>
#include <maya/MFnintArrayData.h>

// COMMAND CLASS DECLARATION
class getCpConVerts : public MPxCommand

{

MStatus
MFnPlugin

status = plugin.registerCommand(“getCpConVerts”, getCpCon-
Verts::creator);
if (Istatus)

return status;

MStatus
MFnPlugin

status = plugin.deregisterCommand(“getCpConVerts");
if (Istatus)

return status;

When initializing the plug-in, we create

public:

MAYA TUTORIAL

status;
plugin(obj, “KAI", “1.0", "Any");

status.perror(“registerCommand”);
return status;

status;
plugin(obj):

status.perror(“deregisterCommand”);
return status;

s
— F RRAPHC Mtk val et i
e [ i

IMAGE 2- MAYA'S PLUG-IN
MANAGER WINDOW SHOWING
THE LOADED PLUG-IN

J

getCpConVerts();
virtual ~getCpConVerts():
MStatus dolt(const MArgList &args);
MStatus redolt();
static void “creator();
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private:

MString conName;

// MEMBER FUNCTION DEFINITIONS

// constructor & destructor
getCpConVerts:getCpConVerts() (|
getCpConVerts:~getCpConVerts() (|

// creator
void *getCpConVerts:creator()
|

return new getCpConVerts;
|

// dolt : fetches node name and then calls redolt
MStatus getCpConVerts:dolt(const MArgList &.args)
{

MStatus status;

// retrieve the arguments
conName = args.asString(0, &status);

status = redolt();
return status;
!

// redolt : returns the list of constrained vertices
MStatus getCpConVerts:redolt()
!
MStatus status;
// put the object on the selection list and retrieve the dag path
MSelectionList sList;
MObiject conObj;
MDagPath conDagPath;

status = sList.add(conName);
if (Istatus) [status.perror(“adding constraint to sel list”); return
status;)

status = sList.getDagPath(0, conDagPath, conObj);
if (Istatus) [status.perror(‘retrieving constraint from sel list");
return status;}

// get handle to the “indexList” array attr

MFnDagNode nodeFn(conDagPath);
MPlug indexListPlug = nodefn.findPlug(“indexList”, &status);

if (Istatus) (status.perror(“retrieving indexList attr plug”); return
status;)

MObject indexListPlugObj;
status = indexListPlug.getValue(indexListPlugObj);

if (Istatus) [status.perror(“retrieving indexList obj from plug”);
return status;}

// get handle to the attr array
MFnintArrayData indexListAttrArray(indexListPlugObj);

long numVerts = indexListAttrArray length();
// return the array of int indexes to the vertices
MPxCommand::clearResult();

for(int i=0; i<numVerts; i++)

MPxCommand::appendToResult(indexListAttrArrayl[il);

// return status

ISSUE 1

return status;
!

// initialize / register
extern “C" MStatus initializePlugin(MODbject obj)
{
MStatus
MFnPlugin

status;
plugin(obj, “KAI", “1.0", “Any");

status = plugin.registerCommand(“getCpConVerts”, getCpCon-
Verts::creator);
if (Istatus)
{
status.perror(“registerCommand”);
return status;
}

return status;
!

// uninitialize / deregister
extern “C" MStatus uninitializePlugin(MODbject obj)
|
MStatus
MFnPlugin

status;
plugin(obj);

status = plugin.deregisterCommand(“getCpConVerts”);
if (Istatus)
|
status.perror(“deregisterCommand”);
return status;
!

return status;

| mentioned earlier that [ would use a front end MEL script to run
the command in order to leave the plug-in as lean and focused on its
task as possible. It is defined as a global proc so that it can be invoked
from anywhere within Maya and performs a number of tasks in the
following order:

—checks to make sure that something is selected

—checks whether the selected node is a cloth constraint and com-
plains if it isn't

—locates the cloth constraint’s associated cloth mesh and complains
if not found

—loads the plug-in if it isn't already loaded

—selects the mesh vertices returned by the plug-in

Here is the MEL code which
www.hdri3d.com/resources.

is also available online at

global proc selectCpConVerts()
{
// return if no objects selected
string $selObjs[] = "Is -sl’;
if ((size($selObjs) == 0))
|
print(*"No cloth constraint selected!\n");
return;

J

// find the actual cloth constraint node
string $clothConNode = “NONE";

string $nodeType = "nodeType $selObjs[0] ;
if (3nodeType == “transform”)

|




string $childNodes[] = “listRelatives -c $selObjs[0] ;
string $childNode;
for ($childNode in $childNodes)
{
string $childNodeType = "nodeType $childNode;
if (gmatch($childNodeType, “cp*Constraint”))
$clothConNode = $childNode;
}

if ($clothConNode == “NONLE")
{
print(“No cloth constraint selected!\n");
return;
}
}
else if (gmatch($nodeType, “cp*Constraint™))
$clothConNode = $selObjs[0];
else
{
print(“No cloth constraint selected!\n");
return;
}

// find the mesh cloth object whose vertices we will select
string $parent[] = "listRelatives -p $clothConNode™;
$parent = ‘listRelatives -p $parent[0] ;

string $clothMeshNode = “NONE™;
string $kids[] = “listRelatives -s -c $parent[0];
string $kid;
for ($kid in $kids)
if ("nodeType $kid* = “mesh”)
$clothMeshNode = $kid;

if ($clothMeshNode == “NONE")

{
print(“Can’t find corresponding cloth object!\n");
return;

// load the plugin if it's not already installed

if (I’ plugininfo -q -1 “getCpConVerts™))

!
print(“Loading the getCpConVerts plugin...\n");
loadPlugin getCpConVerts;

|

// select the vertices at last!
int $indexes|] = getCpConVerts($clothConNode);

select -cl;
int $i, $index;
for($i=0; $i<size($indexes); $i++)
|
$index = $indexes[$i]:
select -add ($clothMeshNode + “vitx[* + $index + “]");

Hopefully, you'll find the MEL code fairly straightforward. It's really just
making use of a few commonly used commands such as Is, listRelatives,
gmatch, nodeType, and select to validate the user’s selection so that the
plug-in doesn't have to. | create such MEL wrapper scripts for most of
the plug-ins | write, especially for node-type plug-ins, to automate the
creation and connection of the node in the dependency graph. This is
a simple APl example, which has hopefully provided some insight into
how data is organized internally in Maya and how to figure out how to
retrieve it using the available classes. It also demonstrates the utility of us-
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IMAGE 3- THE CLOTH
CONSTRAINT SELECTED

IMAGE 4- THE CONSTRAINT'S VERTICES
SELECTED BY THE PLUG-IN

ing front end MEL scripts to wrap the plug-in both for developer and user
convenience. Again, the online documentation is fairly robust, including
a very helpful FAQ section that deserves a good perusing. All you need
now is a compiler and you're on your way! Once compiled, you can test
the plug-in by creating a cloth object, assigning any cloth constraint to it
(i.e. a mesh constraint), selecting the constraint as in Image 3, and then
running the selectCpConVerts wrapper script. You should now see that
in place of the constraint, the vertices contained in it are now selected
as in Image 4. You'll need to have the compiled plug-in in some path
defined in the MAYA_PLUG_IN_PATH environment variable, or you'll
need to load it manually using the Plug-in Manager window accessed
from the Window>Settings/Preferences>Plug-in Manager menu. Happy
constraining! &

KENNETH IBRAHIM'S CAREER IN CG STARTED IN
JAPAN IN THE MID 90'S WHILE WORKING AT SEGA
CREATING GRAPHICS FOR TV COMMERCIALS AND
THEME PARKS AS WELL AS PROGRAMMING SOFT-
WARE TOOLS FOR LARGE ARCADE GAME SYSTEMS
AND LOCATION-BASED ENTERTAINMENT RIDES. HIS
VOICE ALSO APPEARS IN A FEW GAMES, NOTABLY
SEGA RALLY CHAMPIONSHIP. HE THEN JOINED
THE ALIAS/WAVEFRONT TOKYO OFFICE WHERE HE
DEMO'ED, TRAINED, AND SUPPORTED MAYA SINCE ITS ALPHA PHASE.
SINCE RETURNING TO THE US IN '97, KEN HAS WORKED IN FX AND LIGHT-
ING ON A NUMBER OF FEATURE FILMS INCLUDING SHREK, FINAL FANTASY,
MATRIX REVOLUTIONS, X2, PETER PAN, AND |, ROBOT.
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BY HUNTER WOLF

FAKING MULTIPLE CAMERAS

IN LIGHTWAVE

HUNTER WOLF EXPLAINS HOW TO CREATE THE
ILLUSION OF MULTIPLE CAMERAS WITH SINGLE
CAMERA RENDERING.

ne of my favorite things about using computers is that

you can sometimes find homemade workarounds to

limitations in the software. Take Photoshop, for example;
there are a million and one ways to make a cloud. Even if a feature
you need is included in your favorite software application, you can
often times find faster ways to perform a task to suit your needs.

I really enjoy making films in 3D, but one thing | wish Light-
Wave had is the ability to render an entire scene from as many
cameras as | have set up. Imagine a scene with two characters
speaking, and you want the camera to be on the first character,
then switch to the other during the render process. LightWave
allows you to render just one camera at a time. Then you have to
save the scene as a new version, move your camera, and render
the new shot.

FRAME 0- OUR ESTABLISHING SHOT

Of course, in reality, it is best to render very short scenes this
way, and then put them in chronological order in a non-linear film
editing application, such as Final Cut Pro or Premiere Pro (you can
use any film editing software to achieve this, even iMovie and
Windows Movie Maker).

Fortunately, the Graph Editor offers a solution to the camera
limitation, allowing you to change how the camera's curves are
interpolated, so that you can move the camera, providing the
illusion of rendering from multiple cameras.

We'll use the scene at the right for our example. It's an offshore
oil platform I built in Modeler for a film I'm working on. The char-
acter is having flashbacks, remembering that he was at this oil
platfrom sometime in his past. For the scene, | need the camera
to quickly move from one angle to the next, but without a lot of
camera movement. Each shot will take one second (30 frames)
of time to complete, followed by an immediate shot of the third
flashback angle, which occurs over a one-frame duration.

In the first shot, on Frame O, Top Right, | have the camera set
up for an establishing shot, to give the audience a sense of where
they are in the movie.

FRAME 30- A TIGHT SHOT OF THE PLATFORM MANAGER'S OFFICE

On Frame 30, Bottom Right, | move the camera to a close-up
shot of the platform manager’s office.




FRAME 61- "WORM'S EYE VIEW" SHOT

l FIGURE 1- THE GRAPH EDITOR J

l FIGURE 2- NOTE THAT THE CURVES HAVE BECOME STRAIGHT LINES J
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Finally, on Frame 61, Top Left, | move the camera to a low angle
(also called a “Worm's Eye” or “Ant’s Eye” view).

If you were to play this file, using the Preview controls, you'd notice
that the camera is anticipating motion, thus swinging too much.

This is because, by default, the incoming curves, which control
the motion of the camera, are based on Bezier splines. Sometimes
these splines are too organic, providing motion that is too fluid
and almost floaty. Selecting the camera in the scene, then opening
up the Graph Editor, displays this motion in effect. (See Figure I,
center Left).

For the flashback sequence, | want abrupt changes in the camera
angles, like you'd see if watching a slide show. So, to do this, we
need to change these splines to flat, or linear, curves. The Graph
Edior scares a few people because it looks so unwieldy, with all
the curves, grids and stuff. Trust me; once you get to know it, the
Graph Editor will be your best buddy.

Shift-select all of the camera’s channels in the Curve Bin. Next,
right-click and drag a selection around all of the keys in the Curve
Window. Now that they are all highlighted, we can change their
incoming curve type in one fell swoop.

Change the incoming curve, down in the Curve Control panel, from
Bezier Spline to Linear. You will notice that the curves have become
straight lines in the Curve Window. (See Figure 2, bottom Left).

When you make a new preview of the scene, the camera will
move from one angle to the next in quick cuts, without any
rotation of the camera. You can use this technique whenever
you want to produce animations that look like they were cut in a
non-linear editing application. &

HUNTER WOLF (AKA:
DWAYNE J. FERGUSON)
IS A TELEVISION ANIMA-
TION ART DIRECTOR/
SCRIPTWRITER (MUTANT
LEAGUE), AUTHOR (KID
CARAMEL: PRIVATE IN-
VESTIGATOR, AND THE
SUCCESSFUL HAMSTER
VICE COMIC BOOK SERIES). HE IS JUMPING UP
AND DOWN AT THE RELEASE OF HIS SHORT FILM
BLACK ZERO: MERCENARY ANT TO DVD. HIS
WEBSITE IS DIEHARDSTUDIO.COM
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BY ERIC KELLER

hen attacking the problem
of creating cloth effects for
characters using Alias’ Maya,
the most obvious solutions seem to be a

rig involving either Maya's Cloth module or
an implementation of soft-body dynamics
and springs. However, an experienced
computer animator knows that there are
often a great many solutions to almost
any problem and that the most sensible
solution is the one that gets the job done
appropriately. So, really, when attacking
the problem of creating cloth, or any prob-
lem for that matter, the first real task is to
get a handle on what the problem actually
is. If the problem is to create convincing
cloth for a low polygon character that
animates quickly and easily, chances are
the Cloth module or soft-body dynamics
will be overkill. This is especially true if we
want a rig that's easy to work with and that
doesn’'t have to be super realistic — just
realistic enough to add a little extra life to
our character's motion.

This tutorial will demonstrate one way to
add just a little cloth motion to a character’s
sleeve. Truly dynamic simulators are super-
cool (there's no denying that), but then you
often have to deal with caching data and a
rig that can be less responsive. The technique
I describe in this tutorial is designed to be fast
and easy, even as it loses a little realism. It
gets the job done. Remember that it's only
one of many possible solutions; I'm hoping
it will inspire you to envision your own quick
and dirty worlarounds, This rig uses influence
objects and a handy little mel script called
lagLocatormel. It is pretty straightforward,
quick to set up, and very easy to adjust while
animating.

This tutorial assumes you are familiar with
setting up skeletons, binding geometry to
the skeletons using smooth-bind, installing
and using mel scripts, and the basics of
influence objects. We all know that there are
many ways to rig a character, and your pre-
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ferred method may be different from mine,
but that's no reason why you couldn’t apply
this technique to part of your favorite rig.

FIGURE 1- CHARACTER WITH ARM
GEOMETRY SEPARATED

I'll be using one of my low polygon
game-style characters as an example. This
clothing rig works particularly well with
low poly characters, but the same prin-
ciples could be applied to more complex
geometry. My character is a sort of manga
styled girl, she’s a bit on the tomboy side;
she enjoys break dancing, snowboarding,
combat with laser swords, and fuzzy pink
critters that shoot lightning out of their ...
but I digress. Her outfit consists of a floppy
blue jump suit with a hood, big shoes, and
a giant pink hat. I'm focusing on her arm/
sleeve geometry, which | have duplicated
and separated from the rest of her body
(highlighted in figure 1). First, I'll briefly
describe how I set up her arm.

BACKGROUND ON THE ARM SET UP
The arm geometry is comprised of

the sleeve and the hand modeled as two
separate objects (wireframe in figure 2). The

Elbow Joint \ ‘\ :
o
Collar Joint Forearm Joint

FIGURE 2- JOINT SETUP FOR SLEEVE
AND HAND GEOMETRY

hand geometry stops just above the wrist.
The skeleton starts where the collarbone
would be connected to a spine joint, and
then there is the shoulder, the elbow, the
forearm, and finally the hand. I've left the
finger joints off the hand for the sake of
simplicity. This skeleton is a fairly typical
arrangement and one of many possible
arm setups. The forearm is broken into two
joints to properly recreate wrist rotation on
the X-axis. X rotation of the wrist actually
takes place in the forearm, rather than at
the wrist, where the two bones (radius and
ulna) rotate around each other. As far as this
tutorial goes, that's not an essential part of
the rig.

The geometry is smooth bound to the
skeleton. I've set up all of the weighting
for the vertices in a very rudimentary way
by using the Component Editor. | generally
enter weights for all of the bound geom-
etry and then add influence objects where
necessary. You can also use the paint
weight tools if you want a more organic
and intuitive tool for joint weighting. It’s
very simple for this example: the vertices
at the end of the sleeve have a weight
value of | set to the forearm joint. The next
row up (moving in the direction from the
end of the sleeve towards the shoulder) is
set at 0.8 to the forearm, and 0.2 to the el-
bow. The next row is 0.8 to the elbow and
0.2 to the shoulder. The row at the very
center of the elbow is split 0.5 to the elbow
and 0.5 to the shoulder. The row above
the shoulder is set 0.8 to the shoulder and
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i 08 1 shoulder i,

0.2 to shoulder joint,
WA | 2 eit:ow joint

.2 to elbow joint 0.5 to shoulder, ;
0.5 to elbow “

0.8 to forearm joint,
0.2 to elbow joint

1.0 to forearm joint

L FIGURE 3- VALUES FOR SMOOTH BOUND SKIN WHICH | ENTERED MANUALLY INTO THE COMPONENT EDITORJ

0.2 to the elbow. The vertices around the
shoulder are set up in a similar fashion to
the elbow weights I've described, but with
the weights being shared by the shoulder
and collar joints (see figure 3).

SETTING UP INFLUENCE OBJECTS FOR THE
EIBOW AND SHOULDER, A QUICK REVIEW

My joint weighting tends to be very
simplistic since | usually go back and fine
tune with influence objects anyways. If
you've never used an influence object, |
recommend checking out a more in-depth
tutorial, but I'll briefly describe the way |
do it so you can follow along later when |
describe how | use them for cloth effects. |
would recommend the Gnomon Workshop
DVDs on this subject for further study. Most
often, influence objects are used to correct
for joint compression problems. They are
somewhat tedious to rig, but the payoff is
big if you want your geometry to deform
correctly when animating the joints.

Here are the basic steps | use for adding an
influence object to the inside of the elbow:

1. 1 create a piece of polygon geometry.
The shape isn't really important, so a
plane will do nicely. To make it more
obvious what part of the geometry is

being affected by the influence object,
I use the Create Polygon tool and point
snap so that the vertices match the
vertices of the arm geometry. | also
shade it bright red so it stands out
from the character’s geometry.

2. | delete history on the new piece of
geometry.

3. | center the pivot point of the geometry.

4. ] rename it something that will stick out
in the Component Editor; in this case |
use all caps and named it “L_ELBOW_IN-
SIDE_INF_OBJ."

5. | parent this piece of geometry to the
elbow joint.

6. | select the arm geometry, and then the
influence object, and then go to (from

the Animation Menu mode) Skin>Edit

Smooth Skin>Add Influence and choose
the option box. | use these settings:

— Use Geometry should be unchecked
— Drop-off can be at 0.1 (doesn’t matter)
— Lock Weights should be checked

— Default Weight should be at zero
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FIGURE 4- INFLUENCE OBJECTS ADDED TO THE
ELBOW IN AFAIRLY TYPICAL SETUP

As | mentioned before, this really isn't a
tutorial devoted to influence objects, so
I'm not going to explain these options.
For the most part, the default weight
is set to zero so | can set the weights
manually in the Component Editor.

7. Now, when | select the L_ELBOW_IN-
SIDE_INFOB], the arm geometry wireframe
turns purple, indicating that my influence
object has an output connection to the
arm geometry (see figure 4)

8. When | select the vertices of the arm
geometry and open the Component
Editor, | check to make sure L_ELBOW _IN-
SIDE_INFOB] is listed and that it has weight
values of zero (note: sometimes columns
with zeros in them are hidden by default
in the Component Editor, so check the
Options menu in the Component Editor if
things don't look right. If the Component
Editor isn't updating properly, you can try
toggling the Hide Zero Columns option on
and off to get the Editor to behave.).

9. Now | manually enter the weight values
into the Component Editor, just as | did for
the joints. | create a drop-off by sharing the
weight values with the skeleton joints and
other influence objects when appropriate.
Generally for the vertices on the inside of
the elbow, the middle row is set to 1.0 for
the influence object. The rows on either
side are spilt with 0.5 going to the influence
object and 0.5 going to the closest joint.
After | set these weights, | pull the influence
object away from the arm geometry and
make sure it's deforming these vertices
correctly (see figure 5 Next Page).
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FIGURE 5- THE INFLUENCE OBJECT IS PULLED
AWAY FROM THE ARM GEOMETRY JUST TO MAKE
SURE IT'S WORKING CORRECTLY

10. The last step is to use driven keys to
translate, rotate, and scale the influence
objects in such a way as to properly
deform the inside of the elbow as the
elbow joint rotates. | use the elbow joint
as the driver and the influence object as
the driven. | set up additional influence
objects on the outside of the elbow and
around the shoulder. Once a piece of ge-
ometry is turned into an influence object,
its output options are automatically set
so that it will not render.

SETTING UP AND USING LAGLOCATOR.MEL

The laglLocator.mel script is one of
those little gems you find while digging
through the hundreds of free mel scripts
on highend3d.com.

(http://www.highend3d.com/files/
dl.3d?group=melscripts&file_
loc=laglocator-v1.0-.meld&.file_id=2160).

The script was written by Pete Shinners
and can be found under the animation
section in the highend3d.com mel scripts
animation directory. The script is simple to
use and has potential for hundreds of ap-
plications. It’s not as glamorous as Maya's
Cloth Module or soft-body dynamics, but it
is a real time saver. Essentially, it creates a
locator that is parented to whatever object
you have selected when you run the script.
When you animate the parent, this locator
will lag behind it in time and space. It has
two custom attributes that you can control
in the Channel box. These are Lag Offset
and Lag Drag.

!E_:m IDooDoos
) LE0E
= &

Interp Tyce Avevage
Cioth Pin WO 1

~ | INPUTS
lagE suernion?
tima |

Lves Cotors

Deciey =] S

T [ body_ges
vV U g
W Aberd_go0

M oot oo
MG o oo

FIGURE 6- THE LAG LOCATOR IS SHOWN IN GREEN, LAGGING BEHIND THE CLOTHPIN LOCATOR
PARENTED TO THE ELBOW

Lag Offset controls the number of
frames the locator will drag behind. In oth-
er words, it's a temporal lag. Lag Drag will
create the fake dynamics we're looking for
by lagging in distance (it's a spatial lag).
As you would expect, a higher Lag Drag
value will create a larger drag distance for
a more exaggerated effect. To use the
script, put it into your scripts directory,
source the script, select an object and type
“lagLocator” in the command line. That's
all there is to it. Select the Lag Locator
(which will be parented to your object
and most likely named locatorl), and in
the Channel box, you'll find the Lag Offset
and Lag Drag fields. Try creating an empty
scene and use the script on an object just
to get the hang of it.

ADDING THE LAGGING LOCATOR TO
THE SKELETON

OK, now on to the point of this tutorial:
faking cloth movement. The rig I'm using is

pretty simple:

1. I created a locator.

2.1 named it “clothPin.”

3.1 parented it to the forearm joint.

4.1 entered zeros in the Channel box for the
Translate and Rotate values so that the
locator would move to the joint's pivot
point.

5.1 move the clothPin
towards the wrist.

locator down

6. With ‘“clothPin” selected, |
lagLocator script.

7.The Lag Locator script only accounts for
translation, not rotation, so to fix this |
created an orient constraint between
locatorl and the clothPin. This means
that you'll have a lag in the clothes when
the arm moves, but no lag when the
forearm twists. This can always be fixed
with some well-placed keyframes when
it comes time to animate. | haven't tried
writing a script that would take rotation

ran the

into account, but I'm guessing it could
be done fairly easily.

When you replicate this rig, try setting
some keyframes on the arm and move it
around. The locator won't update as you
set the keys, but it will when you play it
and when you scrub through the timeline
(and you don’t have to cache anything!).
Figure 6 should give you the gist of the rig
at this point.

CREATING THE CLOTHING INFLUENCE
OBJECTS

The final part of the setup is to create
some influence objects that will deform the
end of the sleeve. | created eight polygon
objects that match the geometry of the
sleeve’s end using the create polygon tool
with Point Snapping on. To add them as
influence objects, I:
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FIGURE 7- THE EIGHT INFLUENCE OBJECTS ARE
L CONTROLLING THE END OF THE SLEEVE

1. Created each polygon.

2. Deleted history on these polygons.

3. Centered their pivots.

4.Renamed each on in a clockwise manner
starting from the top. The new names are:
“L_SLEEVE_INFOBJ1, L_SLEEVE_INFOBJZ2,
L_SLEEVE_INFON]J3 ... LSLEEVE_INFOBJ8.
See figure 7

5.1 added these objects as influence objects
to the sleeve geometry with the same set-
tings described in the previous section.

6.1 grouped them together.

7.1 renamed the group “L_SLEEVE_IN-
FOBJ_group™ and centered its pivot.

The next step is to weight the vertices of |
the sleeve to the influence objects. To do |
this, I selected the three vertices that com-
prise the edge of the polygons at the end
of the sleeve as shown in figure 8. | went
into the Component Editor and created
the drop-off effect by setting the weights
of the vertices. The vertices on the inside
of the sleeve and all the vertices around
the edge of the sleeves are set to 1.0 for
the influence objects. More specifically,
they are split evenly between the adjacent
influence objects (0.5 and 0.5 for each).
The row of vertices further up the sleeve
share their weights between the forearm
joint and the influence objects. | entered
a value of 0.1 and 0.1 split between the
two influence objects and then 0.2 to the
elbow and 0.6 to the forearm. Once all this
setup is finished, the fun part begins.

ANIMATING THE ARM

The final step is to parent the “L_SLEEVE_
INFOB]_group” to the clothPin locator.
Once | start putting keyframes on the joint
rotations (or using inverse kinematics), the
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cloth motion starts to become obvious,
and it does look pretty cool. During the
process of setting up the keyframes, things
may look a little messed up, but once the
animation is rewound and played, things
should start to look floppy (in a good way).
As | mentioned before, scrubbing through
the animation also shows the floppiness in
action and no caching of data is needed.

The cloth motion can easily be tweaked
by adjusting the Lag Offset and the Lag
Drag channels for locatorl. Also, since the
influence objects that comprise the edge
of the sleeve are grouped and parented to
the clothPin locator, keyframes can be set
on the group, or on the individual influence
objects, in order to correct for any weird
intersections, to simulate stretching, or to
compensate for the fact that there's not
sufficient drag when the forearm rotates. At
this point, it's possible to add a little realism
using good old keyframes, or even by using
driven keys and some artistic sensibility to
make up for what we lost by not using a
dynamic simulation like Maya Cloth.

OTHER RIGS

The ideas in this tutorial are a good foun-
dation for experimentation. The combina-
tion of influence objects and the lag locator
script could be applied to other parts of the
clothing or even to add just a little jiggle to
a pot belly or some fleshy jowls. By point

constraining the end of an IK chain to a
lagging locator, you could add a quick bit
of floppiness to pony tails, stray tentacles,
or sections of a skirt.

For even more tools to simulate cloth,
check out a couple handy scripts in the
Maya 6 Bonus tool pack available on the
Alias Web site. There's a script for adding
multiple influence objects at the same time
and a script for adding secondary motion
to joint chains. Both of these could come
in handy combined with the ideas in this
tutorial.

I hope this tutorial has inspired you.
Please feel free to contact me if you have
any questions. &

ERIC KELLER HAS SPENT
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SCIENTIFIC ANIMATOR AT
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HOME IN WASHINGTON DC. HIS TRAINING IS IN
MUSIC AND ART. HIS PRIMARY TOOLS ARE MAYA,
ZBRUSH, PHOTOSHOP, AND AFTER EFFECTS,
INSPIRATION COMES FROM HIS WIFE ZOE, THEIR
TWQO DOGS AND WAY TOO MUCH TV.
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BY DEUCE BENNETT

ello there everyone — well, a new

magazine, a new article — and

I feel that an introduction is in
order. Everyone calls me Deuce. It is a nick-
name that [ picked up in the film industry
while | was working with my father doing
physical special effects. I have always felt
that having the background in actual film
production has helped me enormously
doing CGI — and | would suggest to anyone
who is in school studying CGl, at least take
a photography class or find some other
way to get behind a real camera. You learn
so much so fast there that directly translates
to the computer.

Now, one of my past passions was de-
stroying things — yes, | blew up buildings,
cars, people — | WAS the life of the party.
But liabilities, insurance, and the supreme
knowledge that | had in my grasp the power
to bring an unhappy end to many people’s life
stories made me feel all the more comfortable
to do these same things now in the computer.
After all, the only way | can hurt someone
with my computer is to throw it at someone
and be lucky enough that they don't duck!

Recently, | have been doing many animated
visualizations for Future Combat Systems for
military contractors and the military directly.
Now, talk about a reason for learning ways
of blowing up CGI vehicles and such! | have
recently hit upon my favorite sprite settings
for Hypervoxels for doing a fireball, and |
would like to show that to you now, with
some explanations along the way.

Ready? Let's get to it!

OK, first, let's think a bit about explosions
— primarily fireballs. OK — so explosions are
primarily a fast affair, with hot gases rising,
burning from an orange-red to a black
smoke afterwards. Scale is key, as some-
thing REALLY BIG moves slooooooow. So
a fast moving fireball will be a small pop,
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like a gas can in a car, to a HUGE fireball
representing a spaceship or a large airplane.
The settings I'm going to be discussing here
should work for “average” fireballs — if you
need smaller, or larger, | hope to explain
things in such a way that you can make
your adjustments as you need.

I'm going to take some liberties here and
make some assumptions. | assume that
you will know how to add particles, and
that you know what the differences in par-
tigons, particle emitters, and Hypervoxels
emitters are. If you don't, there are many
beginner tutorials and lots of information
out there to get you up to speed.

Oh, and one more thing. | want to tell you
right away, here and now, that working with
Hypervoxels is more mysticism and voodoo
than, say, modeling a car. When you are
working with Hypervoxels, trying to do
something like clouds, or fireballs, or any-
thing as ephemeral as these — there are no
hard and fast rules. There are only guidelines,
and it's up to you as the artist to make deci-
sions on “what looks good to you.” What |
hope to do is to explore more the “why” than
“how” — that way, you're more ready to do
your own explorations into making things
look the way you want them to.

OK. What would an explosion be without
some particles? Particles, specifically Hyper-
voxel emitters, are what all my fireballs are
made from.

Let's add a Hypervoxels emitter, make
it real small, say, 50mm each dimension
— and since a fireball is a fast moving af-
fair, let's set our emitter to 100 particles
per FRAME, and only 100 total particles.
Only other thing to set would be to make
it an explosion, of about 20m, in the
Motion Tab. Now, do two things — first,
hit “Calculate” — you will quickly see the
particles moving in their explosion — | do
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SET BACKDROP COLOR TO WHITE SO WE CAN
SEE WHAT WE'RE DOING

| N S

this, because initially, the particles will not
“come from the center” — they seem to be
born “outside” the point of emission; this
just catches the calculations up. Second,
set your background to white — this way,
you should be able to see all of our work
in VIPER.




Now the real work begins. Open Hyper-
voxels and activate our emitter.

I like to think of each particle with
the voxels applied as a single kernel of
popcorn. This is especially true in working
with explosions. If you can remember back,
there used to be a method for creating an
explosion look by morphing spheres with
textures on them. Each sphere would
grow throughout the explosion and dis-
solve out. It didn’t look *that® good then,
but the concept is still kind of the same in
Hypervoxels.

Now let's activate VIPER. Depending on
what frame you activate your VIPER, your
screen might not look like mine (I was on
frame 3 when | made that screenshot).

BLOBS! NOT WHAT WE'RE AFTER

First things first. We are going to be us-
ing Sprite Mode, so turn that from Surface
to Sprite Hypervoxels.

SPRITE MODE - THAT'S FOR US

You'll practically see your Voxels disap-
pear, as the default color is a light grey.
Change that to a full black; it will make it
easier to see our work.
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MAKE ‘EM BLACK - SHOWS UP AGAINST WHITE

Let's work on our texture. For this, I
would turn VIPER to Particle Preview, as it's
easier to see the settings that we make on
a single voxel.

PARTICLE PREVIEW - UP CLOSE WITH A SINGLE
PARTICLE

Now, a word on Sprite Mode. What
it really is, or rather what you should
think of it as, are slices of a volumetric
hypervoxel. Imagine that you have a
cotton ball; if you slice a thin piece out
of the center, then you have “one slice”
— but if you slice one on each side of that,
you have three slices — and so forth up to
a maximum of seven. | use a three slice
because it gives a little more density, but
not so overpowering for my tastes. When

EfT
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Light v
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+ | Automalic Preview
+ | Use Z-Bulfer in Preview
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CHANGE TO THREE SLICE

SAME PARTICLE - WITH THREE SLICES

you do this, you'll see the VIPER adjust,
and they are a little softer now.
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EXPLOSIONS wirH HYPERVOXELS

Click on the HyperTexture Tab, and make
that Crumple Texture active. Because of the
detail that | want to see in the fireball, I turned
up the Frequencies to 8, but | didn’t want a ton
of small details, so I lowered the Small Power
to around .5 — a way to make it your own, or
to make different fireballs unique, is to change
these settings.

Since a fireball is a moving, organic
thing, we need to make our texture move,
so let's do that with the Texture Amplitude
and Texture Effect area. The Texture Ampli-
tude modifies the Crumple Texture that we
have applied. Change it from 50% to 100%
and look at VIPER.
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HIGHER AMPLITUDE TEXTURE

It's getting that grittiness in there better
now, isn't it? Now, here's a little of that
voodoo. Most places in LightWave that you
would think, “Oh, 100% is the maximum"”

:qil HDRI 3D I1SSUE

— isn't the maximum. Change that value to
500% and look at VIPER.

OK, GETTING INTERESTING NOW

See what happens? Now that Crumple
Texture has more character, more like
puffs “inside” one voxel. Change it to
5000% and look.

It now has nice edges inside and soft
edges outside. While we're here, for my
taste, and this changes on the scale of my
explosions, change the Effect Speed to
60% and change the Texture Scale to 1.5
onX,Y and Z.

Uss ZOuler i Provien |
ie Todue Resokion_ v |

TURN UP THE EFFECT SPEED




Right — it's hot, but it's not “always the
same hot,” now is it? Of course not. So we
need to modify this, but not simply with
an envelope. Hit the “T” button to add a
Texture to this.

LET'S WORK IN THE SHADING TAB

Now let's work in the Shading tab.

For what we're going to be working
with, we really have only the three controls
other than color — Luminosity, Opacity and
Density. Luminosity you should know from
working with surfaces; this relates to “how
hot is our fire.”

Well, | first approached this with “Well,
it's hotter than 100%, that’s for sure” — so
change that value to 150-ish (remember
that voodoo?). Sometimes, just grabbing
the spinner and rolling up to “a higher
number” works too.

TURN ON THE LUMINOSITY

T
g =
[ Use ZBuller in Preview
Sprie Texture Reschtion v

GET THAT ‘T"

Right. Now, a gradient would be good
to use here, as it has the ability to “read”
our scene and modify the changes based
on inputs that we can give it. So, change
to a gradient, and let's look at the options
available to us.

CHOICES CHOICES

Out of this list, “Local Density” makes the
most sense, as what we are wanting is to
modify the “hotness” of our voxels based
on “how dense our voxels are” — right? In
order to really see the effect, we're going
to need to change our voxel color from
black to a lighter color, as “a hot black is
still black”™ — understand? Alrighty then,

LIBHTWAVE TUTORIAL

let's make it red, and change our VIPER
preview to Scene preview, and back up to
about frame 1. Then go back into our Gradi-
ent Texture on Local Density. Here's where
you are going to need to look at VIPER as

we make changes.

¥ HyperVoxels 3.0

CALLIN CSI - WE HAVE A SPLATTER
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EXPLOSIONS witH HYPERVOXELS

The gradient is from 0% to 100% — this
is the density of the voxels, with 0% be-
ing the least dense, and 100% being the
most dense. So, with no other keys on the
gradient, make the first and only key 0%
Value and look at VIPER.

BACK IN BLACK

What happened to our red voxels? Well,
they are “cool” or “cold” now. 0% Luminosity
turned them off — and off is black.

OK, so we see this — now, let’s under-
stand “Local Density” — add two more keys
on the gradient, with the next one down
still at 0%, and the next 100%. Look at the
screenshot to help.

:% HDRE 3D I1SSLE!

UNDERSTANDING LOCAL DENSITY

£ Texture Eddtor - HyperVawels - Luminosity

INVERT THEM

Now, with these keys — look at VIPER.

RED ON THE INSIDE, BLACK ON THE OUTSIDE

You see, where the voxels are “thicker”
or more dense, they are “hot,” and where
they get thin out to the edges, they are
black or “cool.” This is what we're going to
use, but because of the way fireballs look,
we're going to reverse this, so that the
thicker parts of the voxel are black. This will
give us the “hot outer” over the black. Yet
again, this is where some voodoo comes
in, and the knowledge of LightWave being
able to accept higher than 100% in values
helps.

Bring out your magic, and set your keys
something like this — my value for the top is
2500%, the second is 800%, and the third
is 90%, with the total bottom being 0%.

One last area to talk about here — and
that is that we can change the Opacity of
this layer as well over time. This will modify
“how” these keys affect the voxels as the
time of the explosion gets later.

Click on the “E” button beside the Layer
Opacity — and put in a curve in the Graph
Editor. Keyframe 100% at frame zero and at
frame 30, then a Linear Constant and Forever
Change through a keyframe at 55 at 105%.
This will make it go darker as time goes on.

T

.
|
|
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THIS WILL MODIFY OUR MODIFY QVER TIME




Now for Opacity. Opacity is one of
those “mystic” areas of Hypervoxels that
for the longest time | did not understand
— but now | think of it like transparency. 0%
Opacity means “it isn't there” — and 100%
Opacity means it's opaque. Got it? Glad |
could help. Now, as an explosion goes on
in its life, it changes from gasses to thick
smoke. So, as the particles age, we want
them to get thicker and thicker.

Voodoo again — (laughing) — OK — [ set
98% for my base, and then opened the “T"
button.

i

+ | Automalic Preview

| Use Z-Buffer in Preview
Sprts Texture Resolution v

OPACITY - AND THE TEXTURE

Choose a gradient, and then base that
gradient on Particle Age.

| AS YOU GET OLDER, YOUR OPACITY CHANGES

I changed the end to be around GO
frames, then added keys.

Bearing in mind, this is a “tune to
taste” — my settings start with the 98%,
then around frame 30 | went to 700%,
finishing with 2000% by frame 40. What
this is doing, is that by frame 40, we're
getting very, VERY opaque. By this time
of the explosion, we're going to be in
mostly smoke, and we want it to be very
opaque.

£ Texture Editor - HyperVoxels - Opacity
I i

SET YOUR KEYS HERE

Last one. Density. This is very much like
Opacity, but this is dealing with the voxels
and how dense the voxels are. Remember
the “Local Density” setting? This is directly
related. 0% dense is gone, 100% dense is
“all there.” Ready? Good.

Crank the Density all the way to 500%.
Then add the “T" to it.

LIGHTWAVE TUTORIAL

Gradient, Particle Age, and set the first
key to 500%.

% Testure Editor - Hypervosels - Density

Now, over time, think of what we want
the voxels to do. We want them to be more
dense as the explosion runs, then less and
less dense as the fireball goes away. This
is the balancing act that we do with the
Opacity — we're saying become more and
more opaque, but less and less dense. Hey,
no one said it would be easy to understand!
Just trust me.

We're starting with 500% Density; we
want this to stay throughout the time of
the explosion’s “meat,” the heart of the
explosion. So this value will stay the same,
500%, through about frame 40, as this is
the time that we have decided the event
will be. Then it will start dying out, being
gone (0%) by frame 70-ish.

72 Texture Edior - HyperVouels - Density

DENSITY OVER TIME
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EXPLOSIONS with HYPERVOXELS

OK, let's get our color in there; this will
be the base color of the fire. Here's where
you can have some creative fun, as this
indicates what kind of fuel is involved.
Perhaps it's an alcohol; this could give

it a green color, or blue, — but I'm after
something along the lines of a good ol
fashioned gasoline fireball. So I'm going to
set my base color around reddish-orange.
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NOW FOR FIRE COLOR

Now, our explosion life is about 70 frames.
We need to have our voxels dissolve out by
that time, but | want to have more control
than simply putting in an Envelope. So click
on the “T” button beside Dissolve.

First thing we're going to add is a Proce-
dural texture called “VALUE” — and make it
100%. | know what you're probably thinking,
“Why not just set it to 100% in the Hypervoxel
panel instead of here?” — well, that setting on
the main panel for Dissolve is an all overriding
setting. We couldn’t do what we're going to
do with it set there. Just follow, and you'll see.

& Texture Editor - HyperVoxels - Dissolve

[AdiLwe =] [Removaime: |
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THIS HAS ADDED VALUE

Now, on top of that, add a Gradient,
based on Particle Age, then set the Start key
at 68% and set another key at around 71 to
100%. Why 71? Seemed right to me. See
screenshot if you're lost with my description
— then, set this to an ALPHA layer. Ahhhh,
see why we needed the Value? We needed
to have this gradient on top of a base that
was “totally dissolved out.” No amount of
reversing the layer or anything would give
this control without the Value added.

#* Texture Edilor - HyperVoxels - Dissolve

SETTING THE GRADIENT ALPHA

As the particles’ ages increase, they will
dissolve out over their age, being gone at
or around 71 frames.

Hey, take a look at VIPER! Looking pretty
good? | think so! But it needs that final
touch. The particles right now, or rather the
voxels right now, are staying the same size
all through the animation. Let’'s make that a
little more “organic.”

LOOKING KINDA LIKE A FIREBALL

I modified my Start Particle size to
230mm; depending on your use or scene,
you might look at changing this; then I
clicked that magic “T" button.

Sprie Texture Resckion v |

YES, MAKE IT BIGGER

You probably guessed, gradient based
on Particle Age. But this works a little dif-
ferently. Most places that you have been
adding a gradient override the value on the
outside panel. Meaning, that a texture over-
rides the setting that you have on the Main
voxel panel. Particle Size is different. The
values you add here do indeed modify the
value on the voxel panel. So, with a 230mm
Starting Size, | set my starting percentage
to 10%, for “very small,” then by frame 20,
the biggest that they will get, I set the value
to 1000% for “very, very big.” This is really
cool, because if you change your scale on
the main panel, then the settings in here
don’t have to change.

AS YOU GET OLDER, YOU GET BIGGER

:q] HDRI 3D 1ssUE!




And hey, look at VIPER now! *GRIN*

MORE FIREBALL

Stretch Direction | use Velocity, about
30-45% and maintain Volume. Adjust to
taste; this is just me.
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OK, final tweaks. Size variation is won-
derful. It makes all the voxels different. I like
a large value here; | use 250%

FIRE! FIRE!

; Use Z-Butfer in Praview
Spre Textue Resoluion v

STRETCH AND VOLUME MAINTAINING

DON'T BURN YOUR COMPUTER

I hope that after you finish reading this
for the first time, then once through with
LightWave running, you will have two
things. One is a fireball preset that you can
use, and two is the understanding of how
we got there so you can modify and make
your own.

Now, just don’t get any burning embers
in your eye — but that's another story for
another time. &

LIGHTWAVE TUTORIAL

JACK “DEUCE” BENNETT Il
IS A FREELANCE CGI
ARTIST WITH A BACK-
GROUND IN  PHYSICAL
SPECIAL EFFECTS FOR
MOTION PICTURES AND
TELEVISION. DEUCE HAS
BEEN WORKING IN THE FILM INDUSTRY HIS
ENTIRE LIFE, AND HAS SUCH MOVIES AS ROBOCOP,
LONESOME DOVE, AND JIMMY NEUTRON: BOY
GENIUS TO HIS CREDIT, AS WELL AS TV SHOWS
LIKE WALKER, TEXAS RANGER. DEUCE HAS BEEN
USING COMPUTERS SINCE HE WAS 9, AND START-
ED OFF WRITING HIS OWN GRAPHIC PROGRAMS.
HE IS A UNIQUE COMBINATION OF PHYSICAL
KNOWLEDGE AND VIRTUAL KNOW-HOW.
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BY DAN ABLAN

auhaus Software has created a

spectacular program that can help

you in your daily work. Sure, that's
a pretty general statement, but when you
learn what Mirage can do, you can find a
way it can be used in your work.

Say you have an image sequence you
need to compile and save out to Quicktime,
or an AVI, or any other compressed format.
Mirage will do that for you. Perhaps you
need to blend two animations or video
clips together; you can do that as well. But
that's nothing, as Mirage is great for film,
video post, broadcast, 2D Animation, 3D
Sweetening, Pre-visualization, and even
Matte Painting. Bauhaus Mirage is a unified
environment that simplifies the creation of
animated graphics and special effects. Com-
bining real-time video paint, animation, and
effects functionality into a single product,
Mirage centralizes the workflow for visual
effects production in film, video, broadcast,
and cartoon/2D animation. To begin,
hard to say what the true power of Mirage is,
as it can be used for so many things. One of
the first things you'll discover with Mirage is

it's

that it has a Sub-Pixel Accurate Paint system.
This paint system can be animated, to create
simple things like animated signatures, to
moving images over video, and even fully
animated drawings and cartoons. Another
cool feature of Mirage is the FX Stack, where
you can apply multiple effects to an image
or sequence. Beyond that, Mirage offers a
powerful keying system for compositing.
You should also know that Mirage offers an
integrated particle system, which is an excel-
lent way to add additional effects to your 3D
sequences or video clips.

But instead of just listing the cool
things Mirage can do, how about working
through a simple tutorial on your own?
This basic tutorial will demonstrate the
cool volumetric lighting effect offered in
Mirage. It's one of my favorites.

:qﬂ HORI 3D ISSUE!

Now, most people think of using this effect
through text, which is of course possible — but
you've seen that. A few years ago, | was
teaching the artists at ABC-TV in New York
how to use LightWave, and they were show-
ing me some of their awesome After Effects
work. They had a shot of a News helicopter
flying over New York City, and as | watched it,
streaks of light bled out of the aircraft, which
transitioned to their animated logo. It was
such a cool effect, but as always, it was done
with an expensive third-party plug-in for
After Effects. So, when | saw that Mirage had
a volumetric lighting feature, | immediately
thought of these types of effects. Going one
step further, Mirage can do it faster. Figure |
shows the final effect produced by Mirage.

Begin by firing up Mirage. You'll need

to set the initial product resolution
to whatever image you choose to use.
Conversely, you can also set a larger
resolution, as Mirage will allow you to
adjust the project size later. Once Mirage
has been started, adjust the interface
so that your primary view is the project
workspace, making the timeline smaller
and out of the way, such as in figure 2.
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FIGURE 1- VOLUMETRIC LIGHTING ISN'T
JUST FOR TEXT, BUT FOR GREAT
LOOKING IMAGE ENHANCEMENTS

FIGURE 2- SET UP YOUR PANELS IN MIRAGE TO SOMETHING LIKE THIS, SO YOU CAN SEE
YOUR ENTIRE WORKSPACE




FIGURE 3- IMPORTING IMAGES OR CLIPS AUTOMATICALLY OPENS THE
IMPORT FOOTAGE PANEL
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FIGURE 4- ADDING THE VOLUMETRIC LIGHT EFFECT TO YOUR IMAGE IS
AS EASY ASASELECTION
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FIGURE 5- IMPORTING IMAGES OR CLIPS AUTOMATICALLY OPENS THE
IMPORT FOOTAGE PANEL
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MIRAGBE TUTORIAL

The next step is to load an image. You can do this by going to the

ile dropdown at the top left of the interface and selecting Load.

But what is even easer is to simply open your folder with an image you
want to use and drag it into the Mirage workspace. Once you import an
image or clip, you'll see the Import Footage panel, as shown in figure 3.

In this panel, you can choose to convert the footage or clip, use
3an Alpha channel and more. For now, just click Import at the
bottom of the panel. Your image will be placed in the project area.
You'll also see the clip entered into the Layers panel.

Now, go up to the Effects dropdown from the top of the
interface, then go to Rendering and choose Volumetric Light.
Figure 4 shows the selections.

You'll note that there are other effects in this area you can
experiment with on your own. For now, you'll see the FX Stack
open with the Volumetric Light effect added, as in figure 5.

When you add the Volumetric Light effect, you'll immediately

see what it's doing on your image. You'll also see a marker
labeled “center.” You can click the green square and move the
volumetric's origin. For this tutorial, I'm using an image of a
room with two windows. You can download this image from
www.3dgarage.com/downloads. Click and drag the green square
to the center of the windows. This will make the volumetric light
generate from that position. figure 6 shows the change.

Now let’s focus on the FX Stack. At the top, you'll see a check

mark with the name of the Effect you're working with. Right
now, you only have one effect, but down the road, as you have
multiple effects in the FX Stack, this setting will be beneficial, as you
can turn an effect on or off quickly and easily. Note that with the
FX Stack open, you can quickly add additional effects (or remove
them) from the controls at the top of the panel.

Move down to the center of the FX Stack and you'll see the

Channel listing. Here, set this to Luminosity, rather than the de-
fault setting. What Mirage will do is create the volumetric light from
the luminous portions of the images; in this case, the windows.
Figure 7 shows the change and effect.
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FIGURE 6-MOVE THE GREEN SQUARE TO THE CENTER OF THE WINDOWS
SO THAT THE VOLUMETRIC IS GENERATED FROM THIS POSITION.
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. FIGURE 7- CHANGING THE CHANNEL SETT ING TO LUMINOSITY MAKES
' THE VOLUMETRIC LIGHT STREAK FROM THE WINDOWS

: EHE
‘EEE_E_
] ].anume!ﬂc Light v |

’ | Rragress Profle| [T Profle/[ 7|

Shariel| (T A
Blend | I T
7 color Same,'

o ,,Hlsh,GUE_ﬁi!‘J:[L_____l_

FIGURE 8- BLEND THE VOLUMETRIC BY
SETTING THE VALUE TO LIGHT

The next category beneath the Channel setting is Blend. This al-
9lows you to change the way the volumetric mixes (blends) with
the rest of the image. You can choose to add to the image, subtract,
multiply, and so on. For this image, try setting this to Light, so that
you have the effect as in figure 8.

1 You can change the color of the volumetric by setting the
Color Source to Image, Gradient or Color. For now, allow the
image to color the volumetric.

1 1You might have noticed that the volumetric, although

streaking from the window, also slightly streaked from the
lampshade. Because the lamp has some luminous quality compared
to the rest of the image, the volumetric effect applies here as well.
Therefore, click the Mask button in the FX Stack. You can easily mask
the volumetric effect with this setting, and you can adjust the mask
by clicking and dragging the red control handles right on the image,
or setting a value in the FX Stack. For this image, a value of 280
worlks well. Figure 9 shows the change.

1 Because a mask is now in place, set the Length value to

80, and the Power to 145. The Power setting increases the
amount of volumetric, while the Length increases the edge of the
volumetric, essentially softening its falloff.

1 One of the last things you can do is apply a Shimmer. This
basically adds streaks to the volumetric light, which you can
then vary with Rotation, Size and more.

1 4Finally. click Apply FX Stack at the bottom of the FX Stack
panel to apply the effect. Then save out the image from
the File menu.

The volumetric lighting effect is very easy to set up as you've seen
here, and Mirage's fast interface allows you to quickly see your work,
which makes setting this effect up sort of fun. But taking this tutorial
one step further, you can animate all of the values! So, imagine this
project taken to the next level. The photo of the room is instead video.
As the camera moves in towards the window, the volumetric light
effect is increased with an animated Power and Length setting. A
few simple keyframes can suddenly bring a regular image or video
sequence to life. Mirage is so powerful that it's hard to express with-
out a 1000 page book, and there are so many possibilities that we'll
continue to provide Mirage tutorials here in HDRI 3D. @&

DAN ABLAN IS PRESIDENT OF AGA DIGITAL STUDIOS,
INC. IN CHICAGO, IL., AND FOUNDER OF 3DGARAGE.COM.
HE HAS WRITTEN EIGHT BOOKS FOR NEW RIDERS PUB-
LISHING ON 3D AND COMPUTER GRAPHICS, AND HAS
RECENTLY PUBLISHED LIGHTWAVE [8: KILLER TIPS
(WITH RANDY SHARP). DAN HAS CREATED A 20 HOUR
LIGHTWAVE COURSE ON CD-ROM, YOU CAN FIND OUT
MORE ABOUT THE COURSE AT 3DGARAGE.COM. DAN IS
ALSO THE EDITOR-IN-CHIEF OF HDRI 3D MAGAZINE.
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Edited by Wes “kurv” Beckwith, Steve Warner, Robin Wood
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N9 | ISBN 1-55622-090-1+6 x 9 » $39:95 + $25.97

LightWave 3D [8] Texturing
Best-selling texturing title
by Leigh van der Byl
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LightWave 3D [8] Lighting ey,
by Nicholas Boughen

ISBN 1-55622-094-4 + 6 x 9 * $5495 « $35.72
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CGlI Filmmaking
by Timothy Albee

ISBN 1-55622-227-0+9x 7 » $/39'9§ - $25.97
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Special 35% off Siggraph discount available for a limited time
only at www.wordware.com/lightwave
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11300 Hartland Street

Go to www.hdri3d.com
for more info!

ONLINE SPECIAL OFFER

QUS $49 01 Rest of World $68

Subscribe to HDRI 3D Magazine
online before December 31, 2004
to get this great discount!

Six issues a year

HDRI 3D presents real world insights and
emerging trends in digital production from
the digital artist's perspective.
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e\ Get Your Upgrades Now
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Integrated Production Suite

VT[4] Systems

Now Available!
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FINAL RENDER

A RESOLUTION ON THE
RESOLUTION OF RESOLUTION

BY ANDREA CARVEY

finally got it! Well, I think | got it. Perhaps

not entirely, but 1 think I've pretty much

figured out the whole resolution thing.
This has been a problem for me for a very
long time — something that others apparently
knew by osmosis or having been abducted by
aliens and programmed with alien informa-
tion during their “visit” (which explains why
many of these people are a little “different”).
At any rate, everyone else seemed to have
fewer problems with it than [ did.

So, why is it so confusing, one might ask?
Gee, let's see! I'd hear the word “resolution”
just about every time | turned around. “Hey,
what's the resolution of that image?” Or,
“That's a cool monitor. What's its resolution?”
Or “To get that to look good in print, you'l
have to render it at a higher resolution.” Or
“I'm going to set the camera’s resolution for
video, so the image will be smaller.” OK, do
you get the problem?

I'd run into big time difficulties when I'd
try to use an image as a texture for a model.
Things would be going along fine, then ...
“Huh? What the heck?! Why is it the size of
Nebraska?" After trying vainly to correct the
situation (even resorting to math), I'd end up
brute forcing it by sizing the image down
3000%. Not very elegant. Another common
way to entertain myself, rather than go out
and enjoy a beautiful day, was to try to print
an image that I'd rendered. "It looked so great
on the screen! What happened?” “Maybe the
printer wasn't working, again. It just printed
out a blank page.” “No, wait. What is that tiny
speck in the center?” "Ahh! Apparently the
resolution was all wrong!” Again.

After spending an hour or two trying
to figure it out myself, I'd slink into Brad's
studio hoping that he had some “free”
time (sure) to go over “resolution” with me
- yet again. (For those of you who don't
know, Brad is my own personal technology
wizard, without whom | would be happily,
blissfully, and peacefully digging up ancient
treasures.) I'd ask Brad what | was doing
wrong, and he'd patiently try to explain
about pixel size, number of pixels on a
monitor, how they can be changed, how
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to increase and decrease resolution, etc.
etc. etc., until my eyes would glaze over
and I'd be transported into my favorite
TV commercial for Corona beer — my own
mini-vacation — complete with palm trees,
sandy beach, lapping water, soft tropical
breeze, quiet, dreamy .. “Do you get it,
now?” he'd ask. Oh crap! What the heck was
he talking about? | can’t ask him to go over
it again! I'd mumble something to the effect
that I indeed got it, and go back and try to
figure it out myself. Usually, | employed the
tried-and-true Trial and Error method. This
method is guaranteed to work — eventually.
The disadvantage is that it takes a lot of
time, but there is one subsidiary acvantage.
It is very productive when your supply of
scrap paper is running low.

It was getting to the point that | was ask-
ing Brad about resolution once a month or
so. His patience was wearing thin and my
confidence was all shot to hell. | just couldn’t
get it. Now, there are very few things that |
just can’'t get — most of which | don't give a
rat’s ass about anyway — such as why Ben
Affleck and Sarah Jessica Parker are consid-
ered to be such hotties. But when Brad began
to just nonchalantly mention to people that
resolution was just something that | would
never grasp | had to do something!

So, | got into my obsessive, Don't-Stop-Un-
til-You-Understand-It mode. | gathered up a
blank notebook, a handful of my favorite pen-
cils (I hate mechanical pencils), and crammed
a whole ream of paper down the craw of the
printer. | was going to figure this out!

I spent a lot of time changing and record-
ing parameters, rendering, printing, and
drawing little diagrams. Slowly, | began to
see a pattern, confusing at first, then sud-
denly the fog lifted. Ah ha! What we had here
was a definitional problem. No wonder | was
... Why
wasn't everyone else confused? The same

confused. Now the question was

term was being used to refer to at least three
different phenomena. It's like using the word
“cat” for cats, laundry and peanuts. [ know
what cats are, but when someone tells me to
put the cats in the dryer, or to go toss some

cats in the backyard for the squirrels, | get
a little confused. Other people, apparently,
have no problem with this.

What | figured out is that apparently the
term “resolution” is used to refer to all of
the following:

+ DISPLAY SETTINGS — such as the number
of pixels or dots per inch that a monitor
displays or that a printer prints

* THE DENSITY OF AN IMAGE - the number
of pixels or dots per inch of an image
AND

+ THE DIMENSIONS OF THE IMAGE OR
MONITOR - such as 600 x 400 pixels, which
is also referred to as the “size” of the image
or monitor. However, “size” also often refers
to the amount of memory needed to store an
image (e.g. 50 K).

You can see the problem. But, why aren’t
other people confused? At first, | thought
that its context in a sentence distinguished
one meaning from another, and |, being un-
aware of this, was lost in a “Who's on First?"
world. So, when someone said, “What's
the resolution of that image?” everyone
(except me) just knew that they meant the
dimensions of the image. Unfortunately,
try as | might, there just doesn't seem to
be anything in the context of that sentence
that would give clues as to its real meaning.
Perhaps there is some subliminal message
that | never received. Maybe it's because |
didn’t watch Star Trek. Ahhh! I'm back at the
beginning! [ just don’t getit! &

BRAD AND ANDREA CARVEY HAVE BEEN
DOING COMPUTER ANIMATIONS FOR A LONG
TIME. IN 1969 BRAD USED AN ANALOG COM-
PUTER, WHICH WAS THE SIZE OF A CAR, TO
PRODUCE HIS FIRST COMPUTER ANIMATION.
ANDREA, AN ARCHEOLOGIST, PREFERS TO
DO SCIENTIFIC ANIMATIONS; HER CRED-
ITS INCLUDE PROGRAMS LIKE DISCOVERY
CHANNEL'S UNDERSTANDING CARS. BRAD
IS AN ELECTRICAL ENGINEER AND AN EMMY
AWARD-WINNING MEMBER OF THE VIDEO
TOASTER DEVELOPMENT TEAM. HE PREFERS
TO DO FEATURE FILM WORK. HIS CREDITS
INCLUDE FILMS LIKE MEN IN BLACK, STUART
LITTLE, BLACK HAWK DOWN, KATE & LEOPOLD
AND MASTER OF DISGUISE.
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